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Глава 4  Ввод в действие CPU 314ST/DPM 
 

В главе описывается ввод в действие CPU 314ST/DPM с технологией 
SPEED7 и его совместное использование с периферийными 
модулями, устанавливаемыми вместе с ЦПУ в стойку на 
"стандартную" заднюю шину и шину SPEED-Bus. 
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Установка на стандартную шину  
 

SLOT1
DCDC

SLOT2

horizontal assembly

lying assembly

vertical
assembly

 

Варианты монтажа  

Пожалуйста, обратите внимания, что допускаются 
следующие температуры окружающей среды : 

• горизонтальный монтаж: от 0 до 60°C 

• вертикальный монтаж:     от 0 до 40°C 

• “лежа”:                     от 0 до 40°C 

 

Если Вы не используете SPEED-Bus модули, то 
применяется следующий порядок выполнения 
монтажа: 
• Прикрепите профильную шину к монтажной плоскости 
болтом M6, так чтобы оставалось свободное 
пространство не менее 65 мм выше и не менее 40 мм 
ниже профильной шины. 

• Если монтажная плоскость представляет собой 
заземленную металлическую конструкцию,  
обеспечьте низкоомное соединение между монтажной 
плоскостью и профильной шиной. 

• Заземлите профильную шину проводником в 
изоляции. Для этого используйте болт M6 на шине. 

• Сечение заземляющего проводника должно быть не 
менее 10мм2. 

 

• Установите источник питания слева на профильной 
шине около заземляющего болта. 

• Зафиксируйте источник питания винтом. 
• Установите в ЦПУ шинный соединитель, как показано 
на рисунке. 

• Установите ЦПУ на профильной шине справа 
вплотную к источнику питания. 

 

• Зафиксируйте ЦПУ винтом, как показано на рисунке. 
• Повторите эту процедуру с периферийными модулями,  
устанавливая в них шинные соединители, сдвигая их 
вплотную влево,  к установленному модулю и 
поворачивая вниз, а затем фиксируя устанавливаемый  
модуль винтом. 

 

Опасность! 

• Источники питания должны быть отключены перед их установкой 
или выполнением  ремонтных работ, т.е. перед началом работ 
необходимо отключить источник питания (вынуть разъем, 
отключить разъединитель)! 

• Все работы должны выполняться квалифицированным персоналом! 
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Установка на SPEED-Bus шину  
 

Для установки  SPEED-Bus модулей используется специальная 
профильная монтажная шина с интегрированной объединительной 
панелью для SPEED-BUS шины. Существуют варианты для установки 
2, 6 или 10 модулей. 
 

SLOT1
DCDC

CPU
SLOT2SLOT3SLOT4SLOT5SLOT6

 
 
 
 

SLOT1
DCDC

CPU
SLOT2

65mm

40mm
 

 

SLOT1
DCDC

CPU
SLOT2

 
 
 

 • Прикрепите профильную шину к монтажной 
плоскости болтом M6, так чтобы оставалось 
свободное пространство не менее 65 мм выше 
и не менее 40 мм ниже профильной шины. 

• Убедитесь, что обеспечено низкоомное 
соединение между профильной шиной и 
монтажной плоскостью 

 
 
 
 
 

• Заземлите профильную шину проводником в 
изоляции.  

Сечение заземляющего проводника должно быть 
не менее 10мм2. 

Профильная шина 

G

12
2

 

  
Заказной номер  SPEED-

Bus 
слот 

A B C 

VIPA 390-1AB60 - 160мм 140мм 10мм 
VIPA 390-1AE80 - 482мм 466мм 8.3мм 
VIPA 390-1AF30 - 530мм 500мм 15мм 
VIPA 390-1AJ30 - 830мм 800мм 15мм 

VIPA 390-9BC00* - 2000мм - 15мм 
VIPA 391-1AF10 2 530мм 500мм 15мм 
VIPA 391-1AF30 6 530мм 500мм 15мм 
VIPA 391-1AF50 10 530мм 500мм 15мм 

* Упаковка из 10 штук 

 
 
 

Специальная 
профильная 
SPEED-Bus  
монтажная шина 

Монтаж про-
фильной шины  
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1 2 3

 

• Снимите отверткой защитную створку в месте 
установки модуля (отожмите и опустите вниз). 
Поскольку SPEED-Bus параллельная шина, то 
разрешается установка модулей SPEED-Bus 
не подряд. Оставьте защитные створки на 
неиспользуемых  разъемах. 
 

 

• Если используется источник питания =24В, 
установите его в слева на SPEED-Bus шине 
как показано на рисунке и сдвиньте его влево к 
заземляющему болту. 

• Зафиксируйте источник питания винтом. 

SLOT1
DCDC

CPU
SLOT2

 

• Для установки модулей SPEED-Bus поместите 
их на шину между треугольными значками в 
разъем, отмеченный "SLOT ...", и прижмите 
его вниз. 

• Только в Слот 1 ("SLOT1 DCDC") разрешается 
устанавливать либо SPEED-Bus модуль, либо 
дополнительный источник питания. 

• Зафиксируйте модули винтом. 

 
 
 
 
 

SLOT1
DCDC

CPU
SLOT2

SLOT2

 

      

• Для использования ЦПУ SPEED7 только с 
шиной SPEED-Bus, установите его между 
треугольными значками в разъем, отмеченный 
"CPU SPEED7", и прижмите его вниз. 

• Зафиксируйте ЦПУ винтом. 

Установка 
модулей  
SPEED-Bus  

Установка ЦПУ 
без модулей на 
стандартной шине 
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SLOT1
DCDC

CPU
SLOT2

SLOT2

 
 

     
 

• Если будут использоваться модули на 
стандартной шине, то перед установкой ЦПУ 
Вы должны вставить шинный соединитель с 
задней стороны, как показано на рисунке. 

• Установите ЦПУ между треугольными 
значками в разъем, отмеченный "CPU 
SPEED7", и прижмите его вниз. 

• Зафиксируйте ЦПУ винтом. 

 
 
 
 
 

SLOT1
DCDC

CPU
SLOT2

 

• Повторите эту процедуру с периферийными 
модулями,  устанавливая в них шинные 
соединители, сдвигая их вплотную влево,  к 
установленному модулю и поворачивая их 
вниз, а затем фиксируя устанавливаемый 
модуль винтом. 
 

 

Опасность! 

• Перед монтажом или ремонтом модулей Серии 300V, источник 
питания должен быть отключен от напряжения (извлеките вилку 
или  удалите предохранитель)! 

• Монтаж и модернизация должна выполняться только 
квалифицированным обученным персоналом! 

Установка ЦПУ с 
модулями на 
стандартной шине 

Установка 
модулей на 
стандартную 
шину  
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Поведение при запуске 
 

После включения источника питания ЦПУ изменяет свой режим 
работы в соответствии с положением переключателя. 
После этого можно загрузить проект в ЦПУ через MPI с 
использованием среды проектирования или вставить MMC с проектом 
и затем выполнить полный перезапуск. 
 
Приведенные ниже рисунки показывают последовательность действий 
при перезапуске: 

PWR

RUN

STOP

SF

FRCE

MCC

PWR

RUN

STOP

SF

FRCE

MCC

PWR

RUN

STOP

SF

FRCE

MCC

PWR

RUN

STOP

SF

FRCE

MCC

1 2 3 4

3 Sec.

3 Sec.

RUN

STOP

MRES

RUN

STOP

MRES

RUN

STOP

MRES

RUN

STOP

MRES

 

Внимание! 
Загрузка программы из ММС в ЦПУ происходит только после полного 
перезапуска! 
 
При поставке память ЦПУ пуста. Если переключить ЦПУ из STOP в 
RUN, то ЦПУ переходит в состояние RUN без программы в памяти. 
 

ЦПУ переходит в состояние RUN с программой, сохраненной в 
батарейковой памяти.  
 
Аккумулятор/батарея автоматически заряжается с использованием 
встроенного источника питания и гарантирует сохранение заряда в 
течение 30 дней. По истечении указанного времени батарея может 
полностью разрядиться, что приведет к стиранию RAM.  
В этом случае ЦПУ при загрузке выполняет полный перезапуск. Если 
MMC установлена, то программный код и блоки данных будут 
загружены из MMC в ЦПУ. Если MMC не установлена, то ЦПУ 
перенесет сохраненные блоки (если они существуют)  из  защищенной 
памяти в рабочую память. Информация о сохранении защищенных 
блоков в ЦПУ описывается в этой главе в разделе "Расширенная 
защита know-how".  
В зависимости от положения переключателя RUN/STOP, ЦПУ 
переключается в  состояние RUN или остается в состоянии STOP.  
При загрузке ЦПУ с разряженной батарей в диагностическом буфере 
появляется сообщение: "Start overall reset automatically (unbuffered 
PowerON)". 

Включение 
источника 
питания  

Полный 
перезапуск 

     

Процедура 
загрузки после 
поставки  

Процедура 
загрузки ЦПУ с 
данными  

Процедура 
загрузки с 
разряженной 
батареей 
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Адресация 
 

Для обращения к установленным модулям ввода/вывода адреса этих 
модулей должны быть определены в центральном процессоре. 
Если аппаратная конфигурация недоступна, можно использовать 
автоматическую адресацию. Для модулей, расположенных на 
стандартной шине, центральный процессор присваивает адреса, 
начиная с адреса 0 для модулей дискретного ввода/вывода и, начиная, 
с  адреса 256 для аналоговых модулей ввода/вывода. 
Модули, размещенные на SPEED-Bus шине, также могут получать 
адреса, используя автоматическую адресацию. Модули дискретного 
ввода/вывода (DIO) получают адреса, начиная со 128, а модули 
аналогового ввода/вывода (AIO), функциональные модули (FM), 
коммуникационные процессора (CP) начиная с адреса 2048. 
 

Центральный процессор, построенный по технологии SPEED7, 
содержит области периферийного ввода/вывода (адреса  0 ... 8191) и 
образ процесса ввода/вывода  (адреса  0 ... 255). 
Образ процесса хранит значения младших адресов (0 ... 255) 
дополнительно в отдельной области памяти. 
Образ процесса делится на две части: 

• образ процесса входов (Process Image Input - PII) 

• образ процесса выходов (Process Image Quit -  PIQ) 
 

I/O area
0
.
.
.
.

255
.
.
.
.

8191

Process image
0
.
.
.

255

0
.
.
.

255

Inputs
PII

Outputs
PIQ

 
 

Образ процесса обновляется автоматически после завершения 
вычислительного цикла контроллера.  
 

В программе конфигурирования оборудовании STEP7 может 
описываться максимум 8 модулей в стойке. Применение SPEED7 ЦПУ 
позволяет размещать до 32 модулей на стандартной шине и 
дополнительно 10 модулей на шине SPEED-Bus. Коммуникационные 
процессоры и DP-master устройства, которые виртуально 
конфигурируются на стандартной шине, входят в число 32 модулей. 
При создании проекта с более чем 8 модулями, используйте 
виртуальное интерфейсное соединение. Для этого установите в 
конфигураторе оборудования модуль IM 360 в слот 3  основной 
стойки. Затем Вы можете расширить систему до 3 стоек, устанавливая 
в остальные стойки модуль IM 361 в слот  3. 

Введение 

Адресация  
устройств  
ввода/вывода, 
установленных 
на задней шине 
 
 

Подключение до 
32 модулей в 
стойке  
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Вы можете обращаться к модулям с операциями чтения и записи 
через область периферийных входов/выходов или через образ 
процесса. 
Для разработки проектов с использованием шины SPEED-Bus 
необходимо подключить SPEEDBUS.GSD файл. Для изменения 
адреса устройств достаточно щелкнуть мышкой на свойстве 
соответствующего модуля и установить желаемый адрес. 
 
 

Внимание! 
При разработке проекта с использованием шины SPEED-Bus 
необходимо следить за тем, чтобы адрес виртуального Profibus-DP 
мастера  не совпадал с адресами реально существующих Profibus-DP 
мастеров. Программа конфигурации фирмы Siemens допускает 
наличие одинаковых адресов у разных Profibus-DP мастеров.  
 
 
Если Вам не нравится использовать программу конфигурации 
оборудования, то  можно воспользоваться автоматической 
адресацией. 
При автоматической адресации модули дискретного ввода/вывода 
(DIO) занимают всегда 4 байта, а  модули аналогового ввода/вывода 
(AIO), функциональные модули (FM), коммуникационные процессора 
(CP) занимают всегда по 16 байт при размещении на стандартной 
шине и по 256 байт при размещении на SPEED-Bus шине. 
В зависимости от номера слота, в котором установлен модуль, 
начальный адрес вычисляется по формуле: 
 
DIO: Начальный адрес = 4·(слот -1)  

AIO, FM, CP: Начальный адрес = 16⋅(слот -1)+256 
 

DIO: Start address = 4⋅(slot -101)+128  

AIO, FMs, CPs: Start address = 256⋅(slot -101)+2048 
 
Приведенную выше информацию можно проиллюстрировать 
следующим рисунком: 
 

CPU 

101102103104 1 2 3 4

... ,102 ,101 1, 2, ...

Start
Address 

digital:
analog:

128
2048

132
2304

136
2560

140
2816

12
304

8
288

4
272

0
256

slot number

 

Определение 
адреса, используя 
аппаратную 
конфигурацию 

 

Автоматическая 
адресация 

Стандартная шина  

SPEED-Bus шина 
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Следующий пример показывает, как функционирует автоматическая 
адресация при размещении модулей отдельно на стандартной и  
SPEED-Bus шине: 
 

0..
8

9....
12

13..
255

256...
320...
335......

2048...
8191

0

1.......
12

13...
255

256....
272

287....
2048...
8191

PII

CPU

 Input Byte

Address  Periphery area

 Input Byte

 Input Byte

Output Byte

Periphery area  Address

an
al

og
di

gi
ta

l

an
al

og
di

gi
ta

l

PIQ

Slot number:            1             2              3              4              5               

 Input Byte

up to max 255

 Output Byte

 Output Byte

 Output Byte

Output Byte

 Output Byte
...

 Input Byte

 Input Byte

Standard busSPEED-Bus

D
I 1

6x
D

C
24

V

A
I 8

x1
2B

it

D
O

 1
6x

D
C

24
V

D
IO

 1
6x

D
C

24
V

A
O

 4
x1

2B
it

up to max 255

 
 

PII

Input Byte

Address   Periphery area

...

Input Byte

Input Byte

Output Byte

Periphery area  Address

an
al

og
di

gi
ta

l

an
al

og
di

gi
ta

l

PIQ

Slot number:  105           104          103           102          101
                    (Slot 5)     (Slot 4)     (Slot 3)      (Slot 2)    (Slot 1)

Input Byte

Input Byte

Input Byte

up to max 255 up to max 255

Output Byte

 Output Byte

 Output Byte

 Output Byte

 Output Byte

CPU 

Standard busSPEED-Bus

D
I 1

6x
D

C
24

V

A
I 8

x1
2B

it

D
O

 1
6x

D
C

24
V

D
IO

 1
6x

D
C

24
V

A
O

 4
x1

2B
it

0........
132

133.........
144

145......255.........
2048......
2816

2831...
8191

0........
132

133........
136

137......255.........
2048.....
2055.........
8191  

Пример 
автоматической 
адресации 
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Для появления ЦПУ в каталоге оборудования необходимо 
импортировать файл SPEEDBUS.GSD в конфигураторе оборудования. 
После установки GSD-файла Вы сможет найти CPU 314ST/DPM в 
разделе Additional field devices \ I/O \ VIPA_SpeedBus. 
Если конфигуратор оборудования недоступен, то адресное 
пространство входов/выходов начинается с 1024 адреса. 
Область входных адресов занимает 48байт, область выходных 
адресов занимает 24байта: 
 
Диапазон входных адресов  

Адрес Тип Назначение  
+0 Byte Дискретные входа I+0.0 ... I+0.7 
+1 Byte Дискретные входа I+1.0 ... I+1.7 
+2 Word Зарезервировано 
+4 Word Аналоговый вход CH0 
+6 Word Аналоговый вход CH1 
+8 Word Аналоговый вход CH2 
+10 Word Аналоговый вход CH3 
+12 Word Аналоговый вход CH4 
+14 Word Зарезервировано 
+16 Double word Счетчик 0 / Фиксация значения 0 
+20 Word Зарезервировано 
+22 Word Слово состояния счетчика 0 
+24 Double word Счетчик 1 / Фиксация значения 1 
+28 Word Зарезервировано 
+30 Word Слово состояния счетчика 1 
+32 Double word Счетчик 2 / Фиксация значения 2 
+36 Word Зарезервировано 
+38 Word Слово состояния счетчика 2 
+40 Double word Счетчик 3 / Фиксация значения 3 
+44 Word Зарезервировано 
+46 Word Слово состояния счетчика 3 

 

Адрес Тип Назначение  
+0 Byte Зарезервировано 
+1 Byte Дискретные выхода Q+1.0 ... Q+1.7 
+2 Word Зарезервировано 
+4 Word Аналоговый выход CH0 
+6 Word Аналоговый выход CH1 
+8 Word Зарезервировано 
+10 Word Слово управления счетчика 0 
+12 Word Зарезервировано 
+14 Word Слово управления счетчика 1 
+16 Word Зарезервировано 
+18 Word Слово управления счетчика 2 
+20 Word Зарезервировано 
+22 Word Слово управления счетчика 3 

 

 
Адресное 
пространство 

Диапазон 
выходных адресов 
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Инициализация интерфейса Ethernet PG/OP  
 

CPU 314ST/DPM имеет встроенный PG/OP интерфейс. Этот 
интерфейс можно использовать для программирования, удаленного 
управления ЦПУ, доступа к встроенному web-интерфейсу или для 
визуализации. На web-интерфейсе отображается информация о 
версии встроенного программного обеспечения, подключенных 
устройствах ввода/вывода, времени цикла ЦПУ и т.д. Для обращения 
к ЦПУ через PG/OP интерфейс необходимо назначить действующий 
IP адрес, т.е. выполнить инициализацию интерфейса. Эта операция 
выполняется в Siemens SIMATIC Manager. Интерфейс поддерживает 
до 4 соединений. 
 

Существуют два способа назначения IP параметров (инициализация): 

• через ПЛК функции, назначая  Ethernet адрес (начиная с версии 
1.6.0 встроенного программного обеспечения) 

• создание проекта с коммуникационным процессором (минимальный 
проект) 

 
Для выполнения конфигурации оборудования необходимо следующее 
программное обеспечение: 

• SIMATIC Manager фирмы Siemens, вер. 5.1 или выше 

• SIMATIC NET 
 

Пожалуйста, обратите внимание, что эта возможность 
поддерживается только с версии 1.6.0 встроенного программного 
обеспечения. Для выполнения инициализации выполните следующее: 

• Определите текущий Ethernet (MAC) адрес интерфейса Ethernet 
PG/OP. Этот адрес указывается под откидной крышкой ЦПУ на 
наклейке с левой стороны. 

 

Ethernet address
Ethernet PG/OP  

Введение 

Способы 
инициализации  

Требования  

Инициализация 
через ПЛК 
функци 
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• Установите соединение между Ethernet PG/OP интерфейсом ЦПУ и 
ПК. 

• Запустите SIMATIC Manager на ПК 

• Вызовите диалоговое окно через пункт меню Options > Set PG/PC 
Interface и задайте параметры связи как "TCP/IP -> Network card .... 
Protocol RFC 1006". 

• Через пункт меню PLC > Assign Ethernet Address вызовите 
диалоговое окно  для инициализации.  

 
• Нажмите на кнопку [Browse] для определения ЦПУ через его MAC 
адреса.   
Поскольку интерфейс Ethernet PG/OP не был инициализирован, то 
будет указан IP адрес 0.0.0.0 и наименование "Onboard PG/OP". 

 
• Выберите этот модуль и нажмите кнопку [OK].  

• Далее необходимо задать IP адрес, маску подсети. IP адрес может 
выделяться DHCP сервером.  В этом случае необходимо выбрать 
опцию "Obtain IP address from a DHCP server" и способ 
идентификации: MAC адрес, имя устройства или Client ID. 
Количество символов для определения Client ID не более 63. 

• Подтвердите сделанные изменения, нажав кнопку [Assign Address]. 
 
После выполнения процедуры инициализации Ethernet PG/OP 
интерфейса Вы всегда сможете обратиться к ЦПУ через SIMATIC 
manager, предварительно установив параметры связи  "TCP/IP -> 
Network card .... Protocol RFC 1006" и задав IP адрес. 
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• Установите соединение между интерфейсом Ethernet PG/OP ЦПУ и 
ПК. 

• Запустите SIMATIC Manager и создайте новый проект. 

• Вставьте новую станцию в проект, вызвав пункт меню Insert > 
Station > SIMATIC 300-Station. 

• Откройте для этой станции конфигурацию оборудования. 

• Вставьте стойку (SIMATIC 300 \ Rack-300 \ Profile rail) 

• Для процессоров SPEED7, конфигурируемых как CPU 318-2, 
вставьте в стойку ЦПУ с заказным № 318-2AJ00-0AB0 V3.0 из 
каталога оборудования. Этот ЦПУ можно найти в  каталоге 
оборудования: SIMATIC 300 \ CPU 300 \ CPU 318-2. 

• Установите CP 343-1EX11 в позицию 4 (SIMATIC 300 \ CP 300 \ 
Industrial Ethernet \ CP 343-1)  

 
 

• Укажите требуемый IP адрес и маску подсети в диалоговом окне 
"Properties" коммуникационного процессора CP 343-1 и подключите 
CP 343-1 к сети "Ethernet". 

• Сохраните и откомпилируйте проект. 

• Перенесите свой проект через MPI или MMC карту на ЦПУ. Более 
подробная информация о способах переноса проекта приведена в 
главе "Перенос проекта ". 
 
После выполнения процедуры инициализации Ethernet PG/OP 
интерфейса Вы всегда сможете обратиться к ЦПУ через SIMATIC 
manager, предварительно установив параметры связи  "TCP/IP -> 
Network card .... Protocol RFC 1006" и задав IP адрес 

 

Инициализация 
через 
минимальный 
проект  
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Доступ к встроенному Web-интерфейсу 
 

Через встроенный в ЦПУ интерфейс Ethernet PG/OP можно получить 
доступ к web-интерфейсу, указав в строке Internet браузера 
назначенный IP адрес. На web-интерфейсе отображается информация 
о версии встроенного программного обеспечения, подключенных 
устройствах ввода/вывода, времени цикла ЦПУ и т.д. 
Текущее содержание web-станицы можно сохранить на MMC 
командой WEBPAGE. Более подробная информация приведена в 
разделе "Командный файл MMC-Cmd". 
 
 
Для доступа к web-интерфейсу необходимо наличие соединения 
между ПК и CPU 314ST/DPM. Проверить наличие такого соединения 
можно с помощью команды Ping, указав ей в качестве  параметра IP 
адрес интерфейса PG/OP. 
 

Web-интерфейс 

 

Для получения доступа указывается IP адрес интерфейса Ethernet 
PG/OP. Web страница отображает данные только по запросу. 
Отображенные данные не меняются до следующего запроса. 
 

 

 

CPU WITH ETHERNET PG/OP   
Slot 100   
VIPA 314-6CF02 V.... Px000077.pkg, 
SERIALNUMBER 11343 

 Заказной №., версия встроенного 
программного обеспечения (ПО), 
имя файла pkg, серийный № 

SUPPORTDATA :  
PRODUCT V3420, HARDWARE V0110, 5679G-V10, 
HX000026.100, Bx000227 V6420, Ax000086 
V1200, Ax000056 V0200, fx000007.wld V1120,  
FlashFileSystem:V102 

 Информация для поддержки 

Memorysizes (Bytes): LoadMem : 524288, 
WorkMemCode : 262144, WorkMemData : 262144 

 Информация о памяти, загрузочная 
память, рабочая память 
(код/данные) 

OnBoardEthernet : MacAddress : 0020D5772C4F, 
IP-Address : , SubnetMask : , Gateway : 

 Ethernet PG/OP: IP параметры 

Cpu state : Stop  Состояние ЦПУ 
FunctionRS485 X2/COM1: MPI 
FunctionRS485 X3/COM2: DPM-async 

 Режим интерфейса RS485  
(MPI, DPM: DP master-устройство) 

Cycletime [microseconds] : min=0 cur=0 ave=0 
max=0 

 Время цикла ЦПУ:  
min= минимальный 
cur= текущий 
max= максимальный 

MCC-Trial-Time: 70:23  Оставшееся время час:мин до 
отключения расширенной памяти,    
если MCC удалена. 

ArmLoad [percent] : cur11, max=33  Информация для поддержки 
продолжение... 

Доступ к web-
интерфейсу 

Требования 
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... продолжение 
 
Slot 201  

 Дополнительные компоненты ЦПУ: 
Слот 201 (DP master) 

VIPA 342-1DA70 V3.1.9 Px000062.pkg,  Наименование, версия встроенного 
ПО, имя файла pkg 

SUPPORTDATA :  
PRODUCT V3190, BB000218 V5190, AB000068 
V4160,  ModuleType CB2C0010, Cycletime 
[microseconds] : min=65535000 cur=0 ave=0 
max=0 cnt=0 

 Информация для поддержки 

   
Slot 206  Слот 206 (Ввод/вывод): 
HS_DI8_DIO8_AI5_AO2, V2.0.6 Px000025.pkg,  Наименование, версия встроенного 

ПО, имя файла pkg 
SUPPORTDATA :  

BB000156 V2060, AB000073 V2020, AB000074 
V2000 PRODUCT V2060, Hx000012 V1000 
ModuleType 8400000 
Address Input 1024...1071 
Address Output 1024...1071 

 Информация для поддержки 

   
SPEED-BUS  Модули на шину speed-bus 
Slot 101  Слот 101  
VIPA 321-1BH70 V1.0.1 Px000029.pkg  Наименование, версия встроенного 

ПО, имя файла pkg 
SUPPORTDATA :  
BB000189 V1010, AB000076 V1010,  
PRODUCT V1010, Hx000013 V1000, 
ModuleType 1FC20001 
Address Input 128...131 

 Информация для поддержки 

Slot 102  Слот 102  
VIPA 322-1BH70 V1.0.1 Px000030.pkg  Наименование, версия встроенного 

ПО, имя файла pkg 
SUPPORTDATA :  
BB000190 V1010, AB000077 V1000,  
PRODUCT V1010, Hx000014 V1000, 
ModuleType AFD00001 

Address Input 132...135 

 Информация для поддержки 

...   
Standard Bus   Модули на стандартной шине 
BaudRate Read Mode1, BaudRate Write Mode1  Информация для поддержки 

   
Line 1: ModuleType 94F9:IM36x  IM интерфейс, если существует  
Rack 0 /Slot 4  № Стойки / № Слота 
ModuleType:9FC3: Digital Input 32 
Baseaddress Input 0 

 Тип модуля  
Назначенный базовый адрес  
если указан, то версия встроенного 
ПО, имя файла pkg 

Rack 0 /Slot 5 ...  № Стойки / № Слота 
...   
Line 2: ModuleType A4FE:IM36x  IM интерфейс, если существует 
Rack 1 /Slot 4   
ModuleType:9FC3: Digital Input 32 
Baseaddress Input 0 

 Тип модуля  
Назначенный базовый адрес  
если указан, то версия встроенного 
ПО, имя файла pkg 

Rack 1 /Slot 5 ...  № Стойки / № Слота 
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Разработка проекта 
 

Разработка проекта с CPU 314-6CF02 выполняется в конфигураторе 
оборудования фирмы Siemens и состоит из следующих частей: 

• Конфигурирование CPU 314ST/DPM как CPU 318-2  
(318-2AJ00-0AB00 V3.0) фирмы Siemens. 

• Описание конфигурации модулей, устанавливаемых на 
стандартную шину. 

• Конфигурирование интерфейса Ethernet PG/OP, как CP 343-1(343-
1EX11). 

• Конфигурирование коммуникационных процессоров SPEED-Bus 
Ethernet-CP 343 и Profibus DP как CP 343-1 (343-1EX11) и CP 342-5 
(342-5DA02 V5.0) соответственно. 

• Описание в конфигурации модулей, устанавливаемых на шину 
SPEED-Bus в качестве DP slaves-устройств виртуального DP 
master-устройства  CP 342-5 (342-5DA02 V5.0). 

 

Для использования интегрированного ввода/вывода, установленного в 
модуле в CPU 314-6CF02 и модулей, установленных на шину SPEED-
Bus, необходимо выполнить следующие операции: 

Standard bus

virtual DP master for CPU
and every SPEEDbus module

real Modules
at the standard bus

CPs resp. DP master
at SPEED-Bus as 
343-1EX11 resp. 342-5DA02

(100) VIPA

VIPA_SPEEDBUS
Order no.
CPU at slot 100

Slot
0

(n) VIPA

VIPA_SPEEDBUS
Order no.
Module at slot n

Slot
0

...

Module

CPU 318-2
DP
MPI/DP

342-5DA02 V5.0

Slot
1
2

X2
X1
3

343-1EX11
(Ethernet PG/OP)

 

• Запустите конфигуратор оборудования фирмы Siemens и 
подключить файл SPEEDBUS.GSD фирмы VIPA. 

• Вставьте в стойку CPU 318-2 фирмы Siemens (заказной № 6ES7 
318-2AJ00-0AB0/V3.0). Переведите субмодуль MPI/DP ЦПУ в 
режим MPI. Режим Profibus для MPI/DP не поддерживается. 

• Установите модули Серии 300 в стойку последовательно, начиная 
со слота 4. 

• Вставьте CP 343-1 (343-1EX11) фирмы Siemens для описания 
встроенного интерфейса Ethernet PG/OP сразу после всех 
установленных модулей. 

• Далее описываются коммуникационные процессора (CP) SPEED-
Bus. Для описания CP Ethernet используйте Siemens CP 343-1 
(343-1EX11), для CP Profibus DP используйте Siemens CP 342-
5DA02 V5.0. 

• SPEED-Bus модули устанавливаются на виртуальную шину 
Profibus. Для создания виртуальной сети Profibus обязательно 
вставьте в конфигурацию последним модуль CP 342-5 (342-5DA02 
V5.0) фирмы Siemens и  переведите его в режим master. 

• Для каждого SPEED-Bus модуля или ЦПУ установите на 
виртуальную шину Profibus slave-устройство "VIPA_SPEEDBUS". 
Адрес устройства в сети Profibus соответствует № слота. 
Адресация начинается с адреса 100 для ЦПУ. Помещайте в слот 
0 каждого slave-устройства соответствующий модуль и, если 
необходимо, измените параметры.  

• Для всех коммуникационных процессоров Ethernet и Profibus DP 
(в том числе для виртуального SPEED-Bus master) установите 
флаг "Save configuration data on the CPU" в панели options. 

     Далее приводится более подробное описание выше действий. 

Введение 

Быстрый старт 
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Конфигуратор оборудования – это часть SIMATIC Manager фирмы 
Siemens, предназначен для конфигурирования проекта. Модули, 
которые используются в проекте, расположены в каталоге 
оборудования. 
Поскольку модули на шине SPEED-Bus и SPEED-Bus ЦПУ 
конфигурируются в виде виртуальной Profibus системы, сначала 
подключите файл SPEEDBUS.GSD фирмы VIPA. 
 

Внимание! 
Для разработки проекта необходимо знание SIMATIC Manager и 
конфигуратора оборудования фирмы Siemens! 
 

Файл GSD (Geräte-Stamm-Datei) в настоящее время существует для 
двух языков. Файлы с другими языками доступны по запросу. 

Наименование  Язык  

SPEEDBUS.GSD Немецкий (по 
умолчанию) 

SPEEDBUS.GSG Немецкий 
SPEEDBUS.GSE Английский 

  
Файл GSD можно скачать с раздела Service сайта www.vipa.de или с 
ftp-сервера по адресу ftp.vipa.de/support/profibus_gsd_files. 
 
Для подключения SPEEDBUS.GSD необходимо выполнить следующие 
операции: 

• Перейти на сайт www.vipa.de. 

• Выбрать Service > Download > GSD- and EDS-Files > Profibus. 

• Загрузить файл Cx000023_Vxxx. 

• Извлечь файл в рабочую директорию. Файл SPEEDBUS.GSD 
сохраняется в директории VIPA_System_300S.   

• Запустить конфигуратор оборудования фирмы Siemens. 

• Закрыть все проекты. 

• Выбрать пункт меню Options > Install new GSD-file. 

• Перейти в директорию VIPA_System_300S и выбрать 
SPEEDBUS.GSD. 

Модули Серии 300S фирмы VIPA располагаются в каталоге 
оборудования Profibus-DP / Additional field devices / I/O / 
VIPA_SPEEDBUS. 

Требования 

    

Подключение 
файла  
SPEED7-GSD 



Глава 4   Ввод в действие CPU 314ST/DPM Руководство VIPA Серии 300S SPEED7 

4-18 HB140E - CPU - RE_314-6CF02 - Издание 09/11 

Ниже описывается последовательность действий при 
конфигурировании проекта на абстрактном примере. 
При конфигурировании оборудования проекта можно выделить пять 
частей:  

• Конфигурирование ЦПУ с DP master-устройством 

• Конфигурирование модулей на стандартной шине 

• Конфигурирование интерфейса PG/OP  

• Конфигурирование коммуникационных процессоров, 
устанавливаемых на шине SPEED-Bus.  

• Конфигурирование ЦПУ и модулей, устанавливаемых на шине в 
виде виртуальной системы Profibus 
 
 

Standard bus (serial)SPEED-Bus (parallel)

DIO AIDP master AI DP masterCP343CP343 DI DO DIO AI AO

DP1DP2 CP1CP2

DO I/O CPU

 
 

• Запустите конфигуратор оборудования, создайте новый проект и 
вставьте стойку из каталога оборудования. 

• Установите в слот 2 CPU 318-2 (6ES7 318-2AJ00-0AB0 V3.0). 

• Для установки режима Profibus DP master в CPU 314-6CF02 
выполните конфигурирование субмодуля DP CPU 318-2. 
Переведите субмодуль MPI/DP CPU 318-2 в режим MPI. Режим 
Profibus для субмодуля MPI/DP не поддерживается. 

 
Standard bus (serial)SPEED-Bus (parallel)

DIO AIDP-Master AI DP-MasterCP343CP343 DI DO DIO AI AO Module

CPU 318-2
DP
MPI/DP

Standard bus
Slot

1
2

X2
X1
3

DO I/O CPU

 
 

Последователь-
ность действий 

Установка обо-
рудования  

Конфигуриро-
вание ЦПУ с  DP 
master-
устройством  
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Для конфигурирования модулей, устанавливаемых на стандартной 
шине, выполните следующие действия: 

• Установите модули Серии 300 в стойку последовательно, начиная 
со слота 4. 

• Измените, если требуется, параметры модулей или ЦПУ (только 
стандартные параметры ЦПУ). Двойное нажатие на модуле 
открывает окно параметров этого модуля. 

 

Module

CPU 318-2
DP
MPI/DP

DI
DO
DIO
AI
AO

Standard bus
Slot

1
2

X2
X1
3
4
5
6
7
8
9

10
11

Standard bus (serial)SPEED-Bus (parallel)

DIO AIDP-Master AI DP-MasterCP343CP343 DI DO DIO AI AODO I/O CPU

 
 

Вставьте CP 343-1 (343-1EX11) фирмы Siemens для описания 
встроенного интерфейса Ethernet PG/OP сразу после всех 
установленных модулей. Коммуникационный процессор расположен в 
каталоге оборудования SIMATIC 300 \ CP 300 \ Industrial Ethernet \ CP 
343-1 \ 6GK7 343-1EX11-0XE0.  
 

Standard bus (serial)SPEED-Bus (parallel)

DIO AIDP-Master AI DP-MasterCP343CP343 DI DO DIO AI AO

Module

CPU 318-2
DP
MPI/DP

DI
DO
DIO
AI
AO
343-1EX11

Standard bus
Slot.

1
2

X2
X1
3
4
5
6
7
8
9

10
11

Ethernet PG/OP channel

DO I/O CPU

 
 
Двойным нажатием на CP 343-1EX11 откройте диалоговое окно 
"Property". Перейдите на панель "General" и нажмите на кнопку 
[Properties]. Установите IP адрес, маску подсети, адрес шлюза и 
выберите желаемую подсеть.  

Конфигурирова-
ние модулей на 
стандартной 
шине 

Конфигурирова-
ние интерфейса 
PG/OP  

Назначение IP 
параметров 
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Конфигурирование коммуникационных процессоров Ethernet-CP 343 - 
SPEED-Bus и SPEED-Bus DP master аналогично конфигурированию 
коммуникационных процессоров фирмы Siemens. Для каждого CP, 
установленного на шине  SPEED-Bus DP, указывайте при 
конфигурировании соответствующий CP фирмы Siemens, 
установленный на обычной шине, устанавливая их после модулей на 
стандартной шине.  
Для описания Ethernet-CP 343 - SPEED-Bus используйте Siemens CP 
343-1 (343-1EX11), для SPEED-Bus Profibus DP используйте Siemens 
CP 342-5DA02 V5.0. 

Standard bus
Slot

1
2

X2
X1
3
4
5
6
7
8
9
11

Standard bus (serial)SPEED-Bus (parallel)

DIO AIDP-Master AI DP-MasterCP343CP343 DI DO DIO AI AO

DP1CP1CP2DP2

Module

CPU 318-2
DP
MPI/DP
IM360
DI
DO
DIO
AI
AO
CP343-1EX11
CP342-5

DO I/O CPU

 
 
 
ЦПУ SPEED7 может обращаться к 32 модулям, установленным на 
шине, но SIMATIC Manager позволяет устанавливать в корзину не 
более 8 модулей. Поэтому при конфигурации создают виртуальную 
шину. Интерфейсный модуль IM 360 устанавливается в слот 3 
основной корзины и интерфейсные модули IM 361, устанавливаются 
слот 3 корзин расширения.  
Поскольку в рассматриваемом примере используется более 8 
модулей, то оставшиеся CP (кроме DP1, установленного в основную 
стойку), устанавливаются в стойку расширения.  
 

Standard busStandard bus (serial)SPEED-Bus (parallel)

DIO AIDP-Master AI DP-MasterCP343CP343 DI DO DIO AI AO

Module

IM361
CP342-5
343-1EX11
343-1EX11

Standard bus
(Extension 1)

Slot
1
2
3
4
5
6
7
8
9
10
11

DP1CP1CP2DP2

Slot
1
2

X2
X1
3
4
5
6
7
8
9
11

Module

CPU 318-2
DP
MPI/DP
IM360
DI
DO
DIO
AI
AO
CP343-1EX11
CP342-5

DO I/O CPU

 

Конфигурирова-
ние коммуника-
ционных процес-
соров SPEED-Bus  

Расширение шины 
с помощью IM 360 
и IM 361 
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Интегрированный ввод/вывод ЦПУ и SPEEED-Bus модули 
устанавливаются на виртуальную шину Profibus Для создания 
виртуальной сети Profibus обязательно вставьте в конфигурацию 
последним модуль CP 342-5 (342-5DA02 V5.0) фирмы Siemens и  
переведите его в режим master. Для каждого SPEED-Bus модуля или 
для ЦПУ установите на виртуальную шину Profibus slave-устройство 
"VIPA_SPEEDBUS", расположенное в каталоге оборудования Profibus 
DP / Additional field devices / I/O / VIPA_SPEEDbus. Этот каталог 
создается после подключения файла SPEEDBUS.GSD. 
 
Адрес устройства в сети Profibus соответствует № слота. Адресация 
начинается с адреса 100 для ЦПУ и продолжается 101...110 для 
модулей SPEED-Bus. Устройство VIPA_SPEEDBUS содержит один 
слот (слот 0). Предварительно назначьте slave-устройству адрес сети 
Profibus и затем установите периферийные модули из каталога "VIPA 
SPEEDBUS" в слот 0 slave-устройства. 
 

Module

CPU 318-2
DP
MPI/DP
IM360
DI
DO
DIO
AI
AO
CP343-1EX11
CP342-5

Standard bus
Slot

1
2

X2
X1
3
4
5
6
7
8
9
10

Standard bus (serial)SPEED-Bus (parallel)

DIO AIDP-Master AI DP-MasterCP343CP343 DI DO DIO AI AO

Module

IM361
CP342-5
343-1EX11
343-1EX11
CP342-5

Standard bus
(Extension 1)

Slot
1
2
3
4
5
6
7
8
9
10
11

101105106107

DP master system for SPEED-Bus modules

102103104108Slot:

(100) VIPA

VIPA_SPEEDbus
Order no.
314-6CF02

Slot
0

(102) VIPA

VIPA_SPEEDbus
Order no.
342-1DA70 - DP-M.

Slot
0

(104) VIPA

VIPA_SPEEDbus
Order no.
331-7AF70 - AI

Slot
0

(106) VIPA

VIPA_SPEEDbus
Order no.
343-1EX71 - CP

Slot
0

(108) VIPA

VIPA_SPEEDbus
Order no.
323-1BH70 - DIO

Slot
0

100

(101) VIPA

VIPA_SPEEDbus
Order no.
322-1BH70 - DO

Slot
0

(103) VIPA

VIPA_SPEEDbus
Order no.
331-7AF70 - AI

Slot
0

(105) VIPA

VIPA_SPEEDbus
Order no.
343-1EX71 - CP

Slot
0

(107) VIPA

VIPA_SPEEDbus
Order no.
342-1DA70 - DP-M.

Slot
0

Setting of the slot
via Profibus address

The according module is to be taken from the
hardware catalog to slot 0 of VIPA_SPEEDBUS.

DO I/O CPU

 
 

Внимание! 
Для всех коммуникационных процессоров Ethernet и DP (в том числе 
для виртуального SPEED-Bus master устройства) установите флаг 
"Save configuration data on the CPU" в панели options! 

Конфигурирование 
ЦПУ и SPEEED-Bus 
модулей  
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Установка параметров ЦПУ 
 

Поскольку ЦПУ SPEED7  31xS фирмы VIPA описывается в 
конфигураторе оборудования как CPU 318-2 (CPU 318-2AJ00 V3.0) 
фирмы Siemens, то стандартные параметры CPU 31xS могут быть 
заданы в диалоговом окне "Object properties" CPU 318-2. Вызов этого 
диалогового окна выполняется двойным нажатием на ЦПУ. 
Параметры ЦПУ сгруппированы на панелях окна по их назначению. 
 

 
 
 
 

Установка 
параметров 
через Siemens 
CPU 318-2AJ00 
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ЦПУ фирмы VIPA поддерживает не все параметры, которые могут 
быть назначены ЦПУ в конфигураторе оборудования.  
Ниже приводится название поддерживаемых параметров в 
диалоговом окне свойств и их описание: 
 
 
 
Краткое описание. Поскольку все CPU 31xS фирмы VIPA при 
конфигурировании описываются как CPU 318-2AJ00 фирмы Siemens, 
то в кратком описании приводятся данные для CPU 318-2AJ00. 
 
Заказной номер и версия встроенного программного обеспечения 
совпадают с описанием модуля в каталоге оборудования. 
 
Имя. В поле задается краткое описание модуля, которое можно 
изменить в случае необходимости. Изменение имени отражается в 
SIMATIC Manager. 
 
Обозначение установки. В поле можно указать обозначение 
установки. Это обозначение присваивается в соответствии с 
функциями установки. Оно имеет иерархическую структуру, в 
соответствии IEC 1346-1. 
  
Комментарий. В поле можно ввести дополнительные комментарии. 
 
 
 
Запускаться в случае отсутствия/несовпадения конфигураций. Если 
поле выбора "Startup when expected/actual configuration differ"  не 
выбрано и хотя бы один из модулей, указанный в конфигурации 
оборудования, не установлен в стойке  или тип модуля в 
конфигурации и в стойке не совпадает, то ЦПУ переходит в режим 
STOP. 
Если поле "Startup when expected/actual configuration differ" выбрано, 
то ЦПУ запускается, даже если модули, указанные в конфигурации 
оборудования, не установлены в стойке или типы модуля в 
конфигурации и в стойке не совпадают. 
 
Контролируемое время формирования сообщения о готовности 
модуля. В этом поле задается максимальное время получения 
сообщений о готовности от всех модулей, описанных в конфигурации 
после подачи напряжения питания. Если модуль не послал в ЦПУ 
сообщение о готовности в течение заданного времени, то считается, 
что текущая конфигурация не совпадает с заданной. 
 
Максимальное время передачи параметров в модули. Если в течение 
заданного времени параметры не были назначены всем модулям, то 
считается, что текущая конфигурация не совпадает с заданной. 
 

Поддерживае-
мые параметры  

Панель General  

Short description 

Order No. / 
Firmware 

Name 

Plant designation 

Comment 

Панель Startup 

Startup when 
expected/actual 
configuration differs 

Monitoring time for 
ready message by 
modules [100ms] 

Monitoring time for 
transfer of 
parameters to 
modules [100ms] 
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Циклически обновлять в OB1 образ процесса. Если эта опция 
выбрана, то происходит автоматическое обновление образа процесса 
в OB1, что приводит к увеличению времени цикла. 
 

Нормируемое время цикла. Если текущее время цикла превысит 
нормируемое время цикла, то ЦПУ перейдет в режим STOP. 
Возможными причинами для превышения времени являются: 

• коммуникационные процессы  
• прерывания  
• ошибка в программе ЦПУ  
 

Минимальное время цикла. Этот параметр задает минимальное время 
цикла выполнения программы. Если время цикла меньше заданного 
времени, то ЦПУ увеличивает время цикла до заданного. 
 

Нагрузка времени цикла от коммуникаций. Используя этот параметр, 
можно управлять продолжительностью коммуникационных процессов, 
которые всегда увеличивают время цикла.  
Без дополнительных асинхронных событий время сканирования цикла 
OB1 умножается на коэффициент, который вычисляется по формуле: 
 

100 
100 - cycle load from communication % 

  

Если выделить 50% загрузки процессора на выполнение 
коммуникационных процессов, время сканирования цикла OB 1 
удвоится. Необходимо учитывать, что время цикла OB1 также зависит 
от асинхронных событий (таких, как прерывания). 
 

Размер образа процесса ввода/вывода. Задается размер образа 
процесса. Максимальный размер области ввода/вывода 2048 байт. 
 
 

Вызов OB85 на ошибку доступа к образу процесса. Вы можете 
изменить реакцию операционной системы на ошибку доступа к образу 
процесса.  
По умолчанию для CPU 31xS фирмы VIPA OB 85 не вызывается в 
случае ошибки и сообщения об ошибке не заносятся в 
диагностический буфер. 
 

Тактовый меркер. Выберите это поле, если хотите использовать 
тактовый меркер и укажите адрес байта памяти. 
 

Внимание! 
Выбранный байт памяти не может использоваться в программе для 
хранения других данных. 

Панель 
Cycle/Clock 
memory 

Update OB1 
process image 
cyclically 
 

Scan cycle 
monitoring time 

Minimum scan  
cycle time 

Scan cycle load 
from Communi-
cation 

Size of the process 
image input/output 
area 

OB85 call up at I/O 
access error 

Clock memory 
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Количество байт памяти, начиная с адреса MB0. Укажите количество 
сохраняемых байт памяти, начиная с 0 байта. 
 

Количество S7 таймеров, начиная с T0. Укажите количество 
сохраняемых таймеров, начиная с T0. Один таймер занимает 2 байта. 
 

Количество S7 счетчиков с C0. Укажите количество сохраняемых S7 
счетчиков, начиная с C0. 
 

Область. Поскольку в VIPA CPU 31xS все блоки данных сохраняются, 
все установки в этой области игнорируются. 
 

 
 
Локальные данные (класс приоритета). В поле задается количество 
локальных (временных) данных для класса приоритета с 1 по 29. 
 

 
 
 
Приоритет. В поле задается приоритет, в соответствии с которым 
обрабатываются указанные прерывания (аппаратные прерывания, 
прерывания с задержкой обработки, прерывания по асинхронной 
ошибке). Прерывания для DPV1 не поддерживаются. 
Организационный блок деактивируется, если ему назначен приоритет 
"0". Обратите внимание, что поддерживается не всеми OB. 
  
 
 
 

Приоритет. В поле задается приоритет, в соответствии с которым 
обрабатываются прерывания по времени суток. Организационный 
блок деактивируется, если ему назначен приоритет "0". 
 
Активность. Выберите поле для того, чтобы активировать обработчик 
прерываний по времени суток автоматически после полного 
перезапуска. 
 
Выполнение. Необходимо указать, как часто будет срабатывать 
прерывание. Доступен широкий интервал: от  1 раз в минуту до 1 раз в 
год. Прерывание срабатывает с указанной начальной даты и времени. 
 
Начальная дата и время. Введите дату и время первого срабатывания 
прерывания. 
 
Разделение образа процесса. Не поддерживается 
 

Панель    
Retentive Memory 

Number of Memory 
Bytes from MB0 

Number of S7 
Timers from T0 

Number of S7 
Counters from C0 

Areas 

Панель Memory 

Local data  
(priority classes) 

Панель Interrupts 

Priority 

Панель Time-of-
day interrupts 

Priority 

Active 

Execution 

Start date / time 

Process image 
partition 
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Приоритет. В поле задается приоритет, в соответствии с которым 
обрабатываются циклические прерывания. Циклическое прерывание, 
деактивируется, если ему назначен приоритет "0". 
 
 
Выполнение. В поле задается периодичность срабатывания 
циклического прерывания в миллисекундах.  Циклическое прерывание 
срабатывает после перехода ЦПУ из режима STOP в режим RUN. 
 
 
Фазовое смещение.  Задание фазового смещения (в миллисекундах) 
позволяет распределить по циклу запуск таймерных прерываний, если 
для них указано одинаковое время цикла. 
  
Разделение образа процесса. Не поддерживается. 
 
 
 
 
Сообщение о причине перехода в режим STOP. Выберите поле, если 
требуется, чтобы ЦПУ  сообщал о причине перехода в режим STOP на 
программатор (PG) или операторскую панель  (OP).  
 
Количество сообщений в диагностическом буфере. Указывается 
количество сообщений в буфере (кольцевой буфер).. 
 
 
Тип синхронизации. Указывается, будет ли выполняться 
синхронизация часов ЦПУ с другими часами: 
- ведомый: Часы синхронизируются от других часов. 
- ведущий: Часы синхронизируют другие часы. 
- нет: Нет синхронизации 
 
Временной интервал. Задается периодичность вызова процедуры 
синхронизации. 
 
Коррекция. В случае ускорение или отставание часов указывается 
величина коррекции в миллисекундах на суточный ход. Если часы 
отстают на 1 секунду за 1 сутки, то необходимо задать значение 
"+1000" мс. 
  
 
 
 

Панель Cyclic 
interrupts 

Priority 

Execution 

Phase offset 

Process image 
partition 

Панель 
Diagnostics/Clock 

Report cause of 
STOP 

Number of 
messages in the 
diagnostics buffer 

Synchronization 
type 

Time interval 

Correction factor 
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Уровень защиты. Можно выбрать 1 из 3 уровней защиты ЦПУ от 
несанкционированного доступа. 
Уровень защиты 1 (установка по умолчанию): 

• Нет ограничений, пароль не задается 
Уровень защиты 2 с паролем: 

• Разрешенный пользователь: доступ на чтение и запись 

• Неразрешенный пользователь: доступ только на чтение  
Уровень защиты 3: 

• Разрешенный пользователь: доступ на чтение и запись 

• Неразрешенный пользователь: нет доступа на чтение и запись 
 

Параметры DP. При двойном нажатии на субмодуле DP открывается 
диалоговое окно свойств. 
 
 
 
Краткое описание. Приводится кратное описание субмодуля "DP". 
 
Заказной номер. 
 
Имя. По умолчанию задано имя "DP", которое можно изменить. 
Изменение имени отражается в SIMATIC Manager. 
 
Интерфейс. Показывает тип интерфейса (Profibus), адрес и имя сети. 
 
Свойства. Нажатие этой кнопки вызывает диалог для изменения 
параметров интерфейса Profibus-DP. 
 
Комментарий. В поле можно ввести дополнительные комментарии о 
назначении интерфейса Profibus. 
 
 
 
Диагностика. Задается диагностический адрес Profibus-DP, 
используемый ЦПУ для диагностики ошибок интерфейса. 
 
Режим работы. Задается режим работы интерфейса Profibus. Более 
подробная информация приведена в главе "Применение Profibus ". 
 
Конфигурация. Для субмодуля в режиме "DP-Slave" можно задавать 
конфигурационные данные. Более подробная информация приведена 
в главе "Применение Profibus ". 
 
Часы. Параметр не поддерживается. 

Панель Protection 

Level of protection 

Parameter for DP 

Панель General 

Short description 

Order no. 

Name 

Interface 

Properties  

Comment 

Панель Addresses 

Diagnostics 

Operating mode 

Configuration 

Clock 
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Параметры MPI/DP. При двойном нажатии на субмодуле MPI/DP, 
открывается диалоговое окно свойств интерфейса MPI. 
 
 
 
Краткое описание. Приводится кратное описание субмодуля "MPI/DP" 
интерфейса MPI. 
 
Заказной номер. Ничего не указано.  
 
Имя. По умолчанию задано имя "MPI/DP", которое можно изменить. 
Изменение имени отражается в SIMATIC Manager. 
 
Тип. Для CPU 31xS разрешается указывать только интерфейс "MPI". 
 
Интерфейс. Показывает тип интерфейса (MPI), адрес и имя сети. 
 
Свойства. Нажатие этой кнопки вызывает диалог для изменения 
параметров интерфейса MPI. 
 
Комментарий. В поле можно ввести дополнительные комментарии о 
назначении интерфейса MPI. 
 
 
 
Диагностика. Задается диагностический адрес MPI, используемый 
ЦПУ для диагностики ошибок интерфейса. 
 
Режим работы, Конфигурация, Часы. Параметры не поддерживаются. 
 
 

Parameter for 
MPI/DP 

Панель General 

Short description 

Order no. 

Name 

Type 

Interface 

Properties  

Comment 

Панель 
Addresses 

Diagnostics 

Operating mode, 
Configuration, 
Clock 
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Установка специфических параметров ЦПУ фирмы VIPA 
 

За исключением специфических параметров ЦПУ фирмы VIPA, 
параметры ЦПУ задаются в диалоге конфигурирования CPU 318-
2AJ00. 
После подключения файла SPEEDBUS.GSD для ЦПУ фирмы VIPA в  
конфигураторе оборудования можно задавать следующие 
специфические параметры ЦПУ: 

• Режим интерфейса RS485  

• Token Watch 

• Количество сохраняемых флагов  

• Приоритет OB 28, OB 29, OB 33, OB 34 

• Выполнение OB 33, OB 34 

• Фазовое смещение OB 33, OB 34 
 

Для конфигурирования специфических параметров ЦПУ фирмы VIPA 
требуется предварительно установить файл SPEEDBUS.GSD в 
каталог оборудования. Далее параметры ЦПУ будут заданы после 
описания виртуальной сети Profibus. 
 

Порядок подключение SPEEDBUS.GSD и конфигурирования 
оборудования описывается в разделе "Разработка проекта ". 
 
 
 
 

Standard bus
Slot

1
2

X2
X1
3
 

Module

CPU 318-2
DP
MPI/DP

virtual DP-Master for CPU

(100) VIPA

VIPA_SPEEDbus
Order. no.
314-6CF02 314ST/DP

Slot
0

always as last module
342-5DA02 V5.0

CPU:
Addr.:100

Object properties  

Двойное нажатие на CPU 314-6CF02 (slave-устройство 
виртуальной сети Profibus), открывает диалоговое 
окно свойств CPU 314-6CF02. 
В этом окне кроме параметров периферийного 
ввода/вывода можно изменять параметры ЦПУ. 
Описание параметров ЦПУ приводится ниже. 
Описание параметров ввода/вывода приводится в 
"Использование периферийного ввода/вывода ". 
 
После переноса проекта в ЦПУ установленные 
параметры вступят в силу после запуска. 
 
 

 

Введение 

Требования 

Конфигурирова-
ние 
оборудования  

Встроенная 
виртуальная сеть 
Profibus  
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Ниже приводятся параметры, которые конфигурируются в свойствах 
ЦПУ, устанавливаемого в slave-устройство "VIPA_SPEEDBUS" на 
виртуальной шине Profibus. 
 

По умолчанию интерфейс RS485 установлен в режим Profibus DP 
master.  
При конфигурировании можно переключить интерфейс RS485 в режим 
соединения точка-точка (PtP) или установить режим синхронизации 
между DP-master Системой и ЦПУ: 
 

Deactivated Интерфейс RS485 отключен 

PtP 
 
 

В этом режиме Profibus DP устройство  
отключено, интерфейс RS485 переведен в 
режим PtP. В режиме PtP происходит обмен 
данными между станциями по различным 
программным протоколам.  
Более подробная информация приведена в 
главе "Ввод в действие PtP соединения". 

Profibus-DP async Асинхронный режим Profibus DP master и ЦПУ.  
Интерфейс RS485 по умолчанию установлен в 
асинхронный режим Profibus-DP, т.е. цикл 
ЦПУ и цикл каждого VIPA Profibus DP master-
устройства выполняются независимо. 

Profibus-DP syncIn ЦПУ ожидает входных данных DP master. 

Profbus-DP syncOut DP master-система ожидает выходных данных 
ЦПУ 

Profibus-DP syncInOut ЦПУ и DP master-истема ожидают друг друга 
и, таким образом, формируют полный цикл 

  
 
 

Обычно ЦПУ и  DP master функционируют независимо. Время цикла 
ЦПУ – это время, необходимое для выполнения одного цикла OB1 и 
выполнения операций чтения/записи входов/выходов. Время цикла DP 
зависит, среди прочего, от количества подключенных slaves-
устройств, скорости обмена данными. Каждое master-устройство 
имеет свое время цикла.   
Благодаря этой асинхронности между ЦПУ и DP master, система в 
целом имеет относительно высокое время реакции. 
Как показано ниже, в конфигураторе оборудования можно установить 
режим синхронизации ЦПУ и Profibus DP master.  
Ниже описываются различные режимы синхронизации. 
 
 

Специфические 
параметры VIPA  

Режим работы 
интерфейса 
RS485 
 

Синхронизация 
между master-
системой и ЦПУ  
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При переводе Profibus-DP в режим SyncInOut ЦПУ и DP Master--
система ожидают друг друга и, таким образом, формируют полный 
цикл. В этом случае полный цикл – это сумма самых длительных 
циклов DP master и цикла ЦПУ. 
В этом режиме синхронизации Вы получаете глобальные 
непротиворечивые данные ввода/вывода, поскольку входные и 
выходные данные обрабатываются в общем цикле последовательно 
ЦПУ и DP master-системой 
Возможно, Вам потребуется увеличить время контроля параметра 
ЦПУ "Scan Cycle Monitoring Time". 

RUN

...SPEED7 CPU

VIPA
DP master system

Cycle

Cycle ...

... ...Cycle

whole cycle  
 
В режиме SyncOut время цикла DP master-системы зависит от 
времени цикла ЦПУ. DP master после завершения своего цикла 
ожидает следующей команды синхронизации с выходными данными 
ЦПУ. 
В этом режиме время отклика системы уменьшается, поскольку 
выходные данные были сразу же переданы в DP master. Возможно, 
Вам потребуется увеличить время контроля параметра ЦПУ "Scan 
Cycle Monitoring Time". 

RUN

... ... ... ...

SPEED7 CPU

VIPA
DP master system

Cycle

RUN

SPEED7 CPU

VIPA
DP master system ... ... ...Cycle

Cycle CPU > DPM
"1-tier CPU cycle"

Cycle CPU < DPM
"n-tier CPU cycle"

Cycle

 
 
В режиме SyncIn ЦПУ синхронизируется с циклом Profibus DP. Время 
цикла ЦПУ зависит от самого длинного цикла DP master-устройства. 
ЦПУ при нахождении в режиме RUN синхронизируется с каждым 
Profibus DP master. После завершении цикла ЦПУ ожидает следующей 
команды синхронизации с входными данными от DP master-системы.  
Возможно, Вам потребуется увеличить время контроля параметра 
ЦПУ "Scan Cycle Monitoring Time". 

RUN

...

...SPEED7 CPU

VIPA
DP master system

Cycle

Cycle

RUN

SPEED7 CPU

VIPA
DP master system

... ...

... ...Cycle

Cycle

Cycle CPU > DPM
"n-tier longest DP master cycle"

Cycle CPU < DPM
"1-tier longest DP master cycle"

 

Profibus-DP 
SyncInOut 

Profibus-DP 
SyncOut 

Profibus-DP  
SyncIn 



Глава 4   Ввод в действие CPU 314ST/DPM Руководство VIPA Серии 300S SPEED7 

4-32 HB140E - CPU - RE_314-6CF02 - Издание 09/11 

Это внутренний параметр VIPA. Изменять значение параметра не 
разрешено.  
Значение по умолчанию: On 
 
Количество сохраняемых флагов. Указывается количество 
сохраняемых байтов области флагов. Если установлено значение 0, 
то применяется значение параметра CPU 318-2 Retentive memory > 
Number of memory bytes starting with MB0. Если значение больше нуля, 
(1... 8192), то применяется установленное значение. 
Значение по умолчанию: 0 
 

Фазовое смещение и выполнение OB33 и OB34. ЦПУ 
предусматривает дополнительные циклические (таймерные) 
прерывания, которые прерывают циклическую обработку. Период 
срабатывания OB отсчитывается от момента перехода ЦПУ из режима 
STOP в RUN . Для того, чтобы избежать запуска различных 
циклических организационных блоков прерываний в одно и то же 
время, существует возможность указать фазовое смещение. 
Фазовое смещение (0 ... 60000мс) предназначено для распределения 
времени выполнения циклических прерываний по циклу.  
Временной интервал, в котором циклическое прерывание OB должно 
выполняться, может лежать в диапазоне 1 ... 60000мс. 
Значение по умолчанию: Фазовый сдвиг: 0 
                          Периодичность выполнения: OB33: 500мс 
                                 OB34: 200мс 
 

Приоритет OB28, OB29, OB33, OB34. Значение приоритета 
определяет порядок обработки указанных прерываний. 
Поддерживаются следующие значения приоритетов: 
0 (OB прерывания отключены), 2,3,4,9,12,16,17,24  
Значение по умолчанию: 24 
 
 

Token Watch 

Number 
remanence flag 

Phase offset and 
execution of OB33 
and OB34 

Priority of OB28, 
OB29, OB33 and 
OB34 
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Установка параметров модулей  
 

В  SIMATIC Manager при конфигурации оборудования можно 
установить требуемые параметры модулей. 
Для выполнения этой процедуры двойным нажатием на требуемом 
модуле вызовите диалоговое окно свойств. В появившемся окне 
можно задать все необходимые параметры. 
 

 
 

Установить требуемые параметры модулей можно во время 
выполнения программы с помощью SFC55, SFC56 и SFC57. 
Для этого параметры модуля должны быть сохранены в так 
называемой "Записи". 
Более подробная информация о структуре "Записи" приводится в 
описании соответствующего модуля 

Способы 
установки 
параметров 

Изменение 
параметров во 
время 
выполнения 
программы  
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Перенос проекта 
 

Перенос проекта в ЦПУ возможен тремя способами: 

• Через интерфейс MPI  

• Через MMC карту 

• Через интерфейс Ethernet PG/OP  
  

 

Перенос проекта через RS485 возможен через два интерфейса: 

• Интерфейс MPI, который поддерживает до 32 соединений  PG/OP  

• Интерфейс PB-DP/PtP, который поддерживает до 31 соединения  
PG/OP (только в режиме Profibus DP master)  

 
Для подключения ПК к ЦПУ требуется специальный кабель MPI для 
программирования, который выпускается фирмой VIPA в нескольких 
вариантах. Для подключения к ЦПУ используется разъем RS485, для 
подключения к ПК  используется разъем USB или разъем RS232.  
Поскольку используется интерфейс RS485, Вы можете подключить 
разъем кабеля MPI для программирования к уже установленному MPI 
разъему в свободное гнездо. Каждый участник сети идентифицирует 
себя в сети по уникальному MPI адресу с учетом того, что  адрес 0 
зарезервирован для программатора.  
 
Структура MPI сети, в общем, идентична структуре Profibus сети. Это 
означает, что в сети  MPI действуют те же самые правила и 
используются те же самые компоненты, что и для Profibus сети. 
Участник сети подключается в сеть с помощью соединителя для сети 
Profibus специальным кабелем Profibus. По умолчанию в ЦПУ 
установлен адрес MPI, равный 2, и скорость сети 187.5 кбод. 
 
 
Кабель сети должен быть согласован по волновому сопротивлению. 
Для этого включите терминальный резистор для первого и последнего 
устройств сети. Для нормальной работы сети эти два устройства 
всегда должны быть под напряжением. 

MPI programming cable

STEP7
from Siemens

MPI/Profibus netTerminating Terminating

 

Введение  

Перенос через 
интерфейс RS485 

MPI кабель 
программирования  

Структура сети  

Терминальный 
резистор  
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• Подключите ПК к MPI разъему ЦПУ с помощью MPI кабеля для 
программирования.  

• Откройте проект в SIMATIC Manager. 

• Выберите пункт меню Options > Set PG/PC interface. 

• В появившемся диалоговом окне из списка выберите "PC Adapter 
(MPI)" и нажмите кнопку [Properties]. Если необходимо, то добавьте 
этот адаптер в список устройств. 

• На вкладке MPI укажите параметры MPI сети и адрес устройства 
MPI. 

• Перейдите на вкладку Local connection. 

• Укажите подключение через COM-порт и скорость 38400 бод для 
MPI кабеля VIPA.  

• Загрузить проект через MPI в ЦПУ  и сохраните его на MMC, вызвав 
пункт меню PLC > Copy RAM to ROM, если ПЗУ (ROM)  вставлено. 

 

• Подключите ПК к DP-PB/PtP разъему ЦПУ с помощью MPI кабеля 
для программирования.  

• Откройте проект в SIMATIC Manager. 

• Выберите пункт меню Options > Set PG/PC interface. 

• В появившемся диалоговом окне из списка выберите "PC Adapter 
(Profibus)" и нажмите кнопку [Properties]. Если необходимо, то 
добавьте этот адаптер в список устройств. 

• На вкладке Profibus укажите параметры Profibus сети и адрес 
устройства Profibus. Profibus адрес должен быть назначен DP 
master-устройству ранее. 

• Перейдите на вкладку Local connection. 

• Укажите подключение через COM-порт и скорость 38400 бод для 
MPI кабеля VIPA.  

• Загрузить проект через MPI в ЦПУ  и сохраните его на MMC, вызвав 
пункт меню PLC > Copy RAM to ROM, если ПЗУ (ROM)  вставлено. 

 

Внимание! 
Перенос через Profibus возможен только, если устройству Profibus 
назначен адрес в сети и установлен режим DP master  
 

Порядок переноса 
проекта через 
интерфейс MPI  

Порядок переноса 
проекта через 
интерфейс 
Profibus  
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MMC карта используется для переноса проекта как носитель данных и 
для обновлений встроенного программного обеспечения. Файловая 
система MMC карты - FAT16.  
На карте можно сохранить несколько проектов и поддиректорий. 
Обратите внимание, что текущий проект и файлы с 
зарезервированными именами должны находиться в корневой 
директории.  
После полного перезапуска, включения питания или перехода из 
режима STOP содержимое MMC карты автоматически 
перечитывается. На поведение ЦПУ оказывает влияние наличие 
файлов с зарезервированными именами. 
 

Имя файла  Описание  

S7PROG.WLD Файл проекта – чтение после полного перезапуска. 
Может быть сохранен на ММС по требованию. 

AUTOLOAD.WLD Файл проекта – чтение после включения питания. 

PROTECT.WLD Файл проекта для защищенных блоков  
(см. "Расширенная know-how защита"). 

VIPA_CMD.MMC Командный файл. Выполняется один раз после 
включения питания при нахождении ЦПУ в режиме  
STOP. (см. "Командный файл MMC-Cmd"). 

*.pkg  Файл для обновления встроенного программного 
обеспечения – определяется после включения 
питания и может быть установлен в случае 
необходимости (см. "Обновление прошивки"). 

 

Перенос проекта с ММС в ЦПУ осуществляется в зависимости от 
имени файла после полного перезапуска или включения питания. При 
переносе проекта мигает светодиод "MCC" на ЦПУ.  
Перенос проекта с ЦПУ на MMC возможен, если размер доступной 
памяти превышает размер проекта. Если размер доступной памяти 
меньше размера проекта, необходимо выполнить операцию сжатия. 
 
Если MMC установлена, команда записи сохраняет содержимое RAM 
в виде файла S7PROG.WLD на MMC. Для вызова команды записи 
выберите пункт меню PLC > Copy RAM to ROM в SIMATIC Manager. Во 
время процесса записи светодиод "MCC" на ЦПУ мигает. После 
завершения записи светодиод гаснет. 
 
После завершения процесса записи на MMC соответствующий 
идентификатор события записывается в диагностический буфер ЦПУ. 
Для просмотра диагностических событий выберите пункт меню PLC > 
Module Information в SIMATIC Manager. В панели "Diagnostic Buffer" 
отображаются все диагностические события.  
Ниже приводится список событий и их идентификаторов, возможных 
при записи на MMC карту. 

Event-ID Meaning 
0xE100 Ошибка доступа к ММС 
0xE101 Ошибка файловой системы MMC  
0xE102 Ошибка FAT MMC  
0xE200 Запись на MMC успешно завершена  

 

Перенос с 
помощью MMC 

Зарезервирован-
ные имена файлов 

Перенос  
MMC →→→→ CPU 

Перенос 
CPU →→→→ MMC 

Контроль за 
операцией 
переноса  
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Для переноса проекта в ЦПУ по сети Ethernet используют интерфейс 
Ethernet PG/OP, который поддерживает до 4 PG/OP соединений. 

Перед применением интерфейса Ethernet PG/OP необходимо 
выполнить процедуру инициализации, т.е. назначить интерфейсу 
необходимые IP параметры. 
 
Для выполнения инициализации потребуется адрес Ethernet (MAC) 
интерфейса Ethernet PG/OP. Этот адрес указывается под откидной 
крышкой ЦПУ на наклейке с левой стороны. Указанный адрес 
начинается с  "EA: ...".  
 

• Подключите ПК и ЦПУ к сети Ethernet. 

• Вызовите в SIMATIC Manager диалоговое окно через пункт меню 
Options > Set PG/PC Interface и задайте параметры связи как 
"TCP/IP -> Network card .... Protocol RFC 1006"". 

• Через пункт меню PLC > Assign Ethernet Address вызовите 
диалоговое окно  для инициализации.  

• Нажмите на кнопку [Browse] для определения MAC адреса ЦПУ.  
Поскольку интерфейс Ethernet PG/OP не был инициализирован, то 
будет указан IP адрес 0.0.0.0 и наименование "Onboard PG/OP". 

После выполнения процедуры инициализации интерфейса Ethernet 
PG/OP, Вы всегда сможете обратиться к ЦПУ через SIMATIC manager, 
предварительно установив параметры связи  "TCP/IP -> Network card 
.... Protocol RFC 1006" и задав IP адрес. Более подробная информация 
приведена в "Инициализации интерфейса Ethernet PG/OP". 
 

• Для переноса откройте проект в SIMATIC Manager. 

• Если этого не было сделано, в SIMATIC Manager вызовите 
диалоговое окно из пункта меню Options > Set PG/PC Interface the и 
установите параметры связи "TCP/IP -> Network card .... Protocol 
RFC 1006". 

• Выберите пункт меню PLC > Download. Откроется диалоговое окно 
"Select target module". Выберите требуемый модуль и введите IP 
адрес интерфейса Ethernet PG/OP. Если какая-либо конфигурация 
оборудования не загружалась в ЦПУ, то ранее назначенный IP 
адрес сохраняется постоянно. 

• Нажмите кнопку [OK], чтобы начать  перенос проекта. Вы получите 
сообщение о том, что загружаемая и текущая конфигурация не 
совпадают. Нажмите кнопку [OK], будет выполнен перенос проекта. 
 

Перенос через 
Ethernet 

Инициализация 

Определение 
Ethernet адреса 

Установка 
соединения  

Перенос 
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Режимы работы  
 

ЦПУ может находиться в одном из 4 режимов: 

• Режим STOP 

• Режим START-UP 

• Режим RUN 

• Режим HOLD 
Режимы работы START-UP и RUN требуют специфической реакции от 
операционной системы. Для этих целей предусмотрены специальные 
организационные блоки, которые образуют интерфейс между 
операционной системой и программой пользователя. 
 
 

• Пользовательская программа не выполняется. 

• Если в ЦПУ выполнялась программа, то действительные значения 
счетчиков, таймеров, флагов и образ процесса сохраняется во 
время перехода процессора в режим STOP. 

• Выходы подавлены, т.е. дискретные выходы сброшены. 

• RUN-светодиод  не горит 

• STOP-светодиод  горит 
 

Во время перехода из режима STOP в режим RUN выполняется 
организационный блок (ОВ) запуска OB100. Длина этого 
организационного блока не ограничена. Время выполнения этого ОВ 
не контролируется. Этот организационный блок может вызывать 
другие блоки. 

• Дискретные выходы сброшены во время START-UP режима, т.е. 
выходы подавлены. 

• RUN-светодиод мигает 

• STOP-светодиод не горит 
Когда ЦПУ заканчивает выполнение OB100, предполагается, что он 
переходит в режим RUN. 
 

• Пользовательская программа обрабатывается циклически в ОВ1. 
Существуют другие организационные блоки, запускаемые по 
событиям. 

• Все таймеры и счетчики, которые используются в программе, 
активны, а образ процесса обновляется каждый цикл. 

• BASP-сигнал (выходы подавлены) снимается, т.е все дискретные 
выходы разрешены. 

• RUN-светодиод  горит 

• STOP-светодиод не горит 
 

Введение 

Режим STOP 

Режим START-UP 

Режим RUN 
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ЦПУ предоставляет возможность установить до 4 точек останова для 
выполнения диагностики программы. Установка и удаление точек 
останова производится в программной оболочке. При достижении 
точки останова Вы можете выполнять программу пошагово, при этом 
входы и выходы активны. 
 

Для использования точек останова, должны быть выполнены 
следующие условия:  

• Пошаговый режим возможен, если программа написана на STL. 
Если программа написана  на другом языке, необходимо 
переключиться в представление STL, выбрав View > STL . 

• Блоки должны быть открыты в он-лайн режиме и не должны быть 
защищены.  

• Открытый блок не должен быть изменен в редакторе. 
 

• Выбрать подменю View > Breakpoint Bar.  

• Установить курсор в строке, где Вы хотите вставить точку 
останова.. 

• Установить точку останова, выбрав Debug > Set Breakpoint. 
Выбранная строка будет отмечена окружностью. 

• Активировать точку останова, выбрав Debug > Breakpoints Active. 
Окружность будет закрашена.  

• Переведите ЦПУ в режим RUN. Когда программа достигнет точки 
останова, ЦПУ перейдет режим HOLD, точка останова будет 
отмечена стрелкой, а содержимое регистров будет 
контролироваться. 

• Потом Вы можете выполнить программный код пошагово, выбрав 
Debug > Execute Next Statement или запустив программу до 
следующей точки останова, выбрав Debug > Resume.  

• Удалить все точки останова можно выбрав подпункт меню Debug > 
Delete All Breakpoints. 

 

• Индикатор RUN мигает и индикатор STOP горит. 

• Выполнение кода остановлено. Организационные блоки не 
выполняются. 

• Все программные таймеры заморожены. 

• Встроенные часы идут. 

• Выходы отключены, но могут быть разблокированы в тестовых 
целях. 

• Возможен пассивный обмен данными. 
 

Внимание! 
Всегда возможно использование точек останова. Переключение в 
тестовый режим не требуется.  
С более чем 3 точками останова пошаговое выполнение программы 
невозможно.  

Режим HOLD 

Предварительные 
условия 

Работа с точками 
останова 

Поведение в 
режиме HOLD 
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ЦПУ имеет механизмы безопасности, такие как сторожевой таймер 
(100мс) и задаваемое время контроля длительности цикла (задается 
от 1 мс), которое приводит к остановке или сбросу ЦПУ в случае 
ошибки и переводит его в предопределенное  состояние STOP. 
ЦПУ фирмы VIPA содержит функции безопасности, которые имеют 
следующие системные свойства: 
 

Событие Область действия Действие 

RUN → STOP Общая BASP (Befehls-Ausgabe-Sperre, т.е. команда 
блокирования выходов) активна 

 Центральная корзина - 
дискретные выходы  

Выхода принимают значение 0В 

 Центральная корзина -
аналоговые выходы 

Питающее напряжение выходных каналов 
отключается. 

 Децентрализованная 
периферия – выходы  

Выходы принимают значение 0В 

 Децентрализованная 
периферия – входы 

Входы считываются непрерывно от slave -
устройства и помещаются в память ЦПУ 

STOP → RUN 
или подача 
питания 

Общая В начале удаляется PII, затем вызывается  
OB100. После выполнения OB100, BASP 
сбрасывается и выполняется следующая 
последовательность:   
Удаляется PIO → Читается PII → OB 1 

 Централизованные и 
децентрализованные 
аналоговые выходы 

Значение выходов при перезапуске может быть 
предопределено  

 Децентрализованная 
периферия – входы 

Входы считываются непрерывно от slave-
устройства и помещаются в память ЦПУ 

RUN Общая Происходит циклическое выполнение 
программы со следующей 
последовательностью:  
Считывается PII → OB1 → Записываются 
данные в PIO. 

 
PII = Process image inputs (Образ процесса входов) 
PIO = Process image outputs (Образ процесса выходов) 

Функции 
безопасности  
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Полный перезапуск 
 

Во время полного перезапуска вся пользовательская память (RAM) 
стирается. Данные, размещенные на карте памяти, не стираются. 
Выполнить полный перезапуск можно двумя способами: 

• с использованием переключателя, установленного на ЦПУ  

• с использованием SIMATIC Manager 
 

Внимание! 
Вы должны всегда применять полный перезапуск ЦПУ перед загрузкой 
программы, чтобы обеспечить полное стирание старых блоков.  

 

Условия 
Переведите ЦПУ в режим STOP. Для этого функциональный 
переключатель ЦПУ переведите в позицию  "STOP"  → загорится 
светодиод STOP. 
 
Полный перезапуск 

• Переведите функциональный переключатель в позицию MRES и 
удерживайте его в этой позиции в течение 3 секунд → светодиод  
STOP начнет мигать. 

• Верните функциональный переключатель в позицию STOP и снова 
переключите его в позицию MRES, а затем быстро (менее 3 секунд) 
верните его назад в позицию STOP→ светодиод STOP мигает 
(выполняется полный перезапуск). 

• Светодиод STOP снова станет гореть постоянно после завершения 
полного перезапуска. 

 
Приведенные ниже рисунки демонстрируют описанную выше 
процедуру: 
 

PWR

RUN

STOP

SF

FRCE

MCC

PWR

RUN

STOP

SF

FRCE

MCC

PWR

RUN

STOP

SF

FRCE

MCC

PWR

RUN

STOP

SF

FRCE

MCC

1 2 3 4

3 Sec.

3 Sec.

RUN

STOP

MRES

RUN

STOP

MRES

RUN

STOP

MRES

RUN

STOP

MRES

 

Введение 

     

Полный 
перезапуск с 
помощью 
функционального 
переключателя  
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В этом действии ЦПУ пытается перезагрузить параметры и программу 
с карты памяти → светодиод MCC мигает. 
После завершения перезагрузки светодиод MCC гаснет. ЦПУ 
перейдет в режим STOP или RUN (в зависимости от положения 
функционального переключателя). 
 

Условия 
ЦПУ должен находиться в режиме STOP.  
Для перевода ЦПУ в режим STOP вызовите  окно для установки 
режима из пункта меню PLC > Diagnostic/Settings>Operating mode. В 
диалоговом окне переведите ЦПУ в режим STOP. 
 
Полный перезапуск  

Для полного перезапуска выберите пункт меню PLC > 
Diagnostic/Settings>Clean/Reset. 
Во время перезапуска светодиод STOP мигает. После завершения 
полного перезапуска светодиод STOP горит постоянно. 
 

В этом действии ЦПУ пытается перезагрузить параметры и программу 
с карты памяти → светодиод MCC мигает. 
После завершения перезагрузки светодиод MCC гаснет. ЦПУ 
переходит в режим STOP или RUN в зависимости от положения 
функционального переключателя. 
 

Описанные ниже действия полностью очищают встроенную RAM и 
возвращают заводские уставки ЦПУ. 
Пожалуйста, обратите внимание, что адрес MPI станет равным 2! 

• Удерживайте внизу функциональный переключатель в течение 30 
секунд. Сначала несколько секунд светодиод ST мигает, а затем 
начинает гореть постоянно. Изменение состояние светодиода 
повторяется несколько раз. Подсчитайте количество фаз с 
постоянным горением светодиода. 

• После 6 фаз постоянного горения светодиода отпустите 
функциональный переключатель и вновь опустите его вниз на 1 
секунду. После этого светодиод  RUN загорится и погаснет, что 
означает полную очистку RAM. 

• Выключите питание и включите его снова. 
 
Более подробная информация приведена ниже в "Сброс к заводским 
уставкам". 
 
 

Автоматическая 
перезагрузка 

Полный 
перезапуск с 
помощью 
SIMATIC Manager 

Автоматическая 
перезагрузка 

Возврат к 
заводским 
уставкам 
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Обновление прошивки 
 

Обновление встроенного программного обеспечения (прошивки) 
удобно выполнять с использованием MMC. Для обновления прошивки 
необходимо, чтобы во время запуска ЦПУ в нем была установлена 
специально подготовленная MMC. 
Файлы прошивки, расположенные на MMC, обнаруживаются при 
запуске. Для каждого релиза обновляемого компонента создается 
отдельный pkg файл с уникальным именем, которое начинается с "px" 
и далее содержит шесть цифр. С правой стороны откидной крышки 
ЦПУ указывается перечень прошитых pkg файлов каждого 
обновляемого компонента. 
Если во время запуска ЦПУ на MMC карте находятся pkg файлы с 
более новой версией прошивки, чем  уже установленные версии, то 
ЦПУ загружает эти новые версии прошивки из файлов. 
 

Firmware package and version 

Последние версии прошивки можно найти в разделе "service" на сайте 
www.vipa.de или на ftp сервере по адресу ftp.vipa.de/support/firmware. 
Например, следующий файл необходим для обновления прошивки 
CPU 314-6CF02 и его компонентов (Profibus) с релизом 1: 

• 314-6CF02, релиз 1:                                           Px000077_V... zip 

• Profibus DP master (встроенный/SPEED-Bus):      Px000062_V ... zip 

• DI/DO/AIO                                                                  Px000025__V... 
zip 

 

Внимание! 
Во время установки новой прошивки Вы должны быть чрезвычайно 
аккуратны. При определенных обстоятельствах Вы можете повредить 
ЦПУ, например, если во время передачи новой прошивки пропадет 
питающее напряжение, или если новая прошивка окажется 
поврежденной. 
В этом случае необходимо обратиться в центр поддержки VIPA! 
Пожалуйста, обратите внимание, что версия обновления прошивки 
должна отличаться от уже установленной версии. Если версии 
совпадают, то операция обновления прошивки не будет выполнена. 
 

Введение  

Последние 
версии прошивки 
на ftp.vipa.de 
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Каждый ЦПУ SPEED7 имеет встроенный web-интерфейс, на котором 
отображается, среди прочего, информация о версии встроенного 
программного обеспечения (прошивки). Доступ к встроенному web-
интерфейсу возможен через интерфейс Ethernet PG/OP, 
предварительно назначив этому интерфейсу необходимые IP 
параметры, т.е. выполнив инициализацию. Инициализацию 
интерфейса PG/OP можно выполнить при переносе конфигурации 
оборудования по интерфейсу MPI, с помощью MMC или используя 
Siemens SIMATIC Manager через пункт меню PLC > Assign Ethernet 
Address. 
Для получения доступа к встроенному web-интерфейсу после его 
инициализации введите адрес PG/OP интерфейса в строке  Internet 
браузера. Более подробная информация приведена в "Инициализация 
интерфейса Ethernet PG/OP". 
 

• Зайдите на сайт http://www.vipa.de/en. 

• Перейдите по ссылке Service > Download > Firmware Updates. 

• Выберите "Firmware for System 300S CPUs" 

• Выберите соответствующие модули (ЦПУ, DP master) и загрузите 
прошивку Px......zip на ПК. 

• Извлеките файлы из архива и скопируйте их на MMC. 
 

 
Для получения доступа к ftp серверу необходимо: 
Internet Explorer 
Доступ по ftp возможен только для версии 5.5 или выше  

Вызовите пункт меню Options > Internet options, Register "Advanced" 
и в поле "Browsing": 

- выберите: "Enable folder view for ftp sites" 
- выберите: "Use passive ftp ..." 

 
Netscape 
Доступ по ftp возможен только для версии 6.0 или выше  
Дополнительных действий не требуется 
 
Если после выполнения указанных действий ftp доступ затруднен, 
обратитесь к системному администратору. 
 

Внимание! 
Для обновления прошивки выполняется полный перезапуск ЦПУ. Если 
пользовательская программа находится только в загрузочной памяти, 
то она будет удалена! Поэтому всегда сохраняйте пользовательскую 
программу перед выполнением прошивки! После выполнения 
прошивки необходимо выполнить возврат к заводским уставкам (см. 
описание ниже). 

Отображение 
версии прошивки 
через web-
интерфейс  

Загрузка 
прошивки и 
перенос на MMC 

Условия для ftp 
доступа 
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1. Установите переключать RUN-STOP ЦПУ в положение STOP. 
Выключите питание. Вставьте MMC с файлами прошивки в 
ЦПУ. Обратите внимание на правильную установку MMC. 
Включите питание. 

2. После небольшой паузы при загрузке Вы увидите, что мигание 
светодиодов SF и FRCE происходит в противофазе (см. 
рисунок ниже). Изменение состояния светодиодов означает, 
что на MMC найдена более новая версия прошивки. 

3. Для выполнения операции прошивки удерживайте 
переключатель RUN/STOP в нижнем положении (MRES) в 
течение 10 секунд.  

4. Во время прошивки состояние светодиодов SF и FRCE 
меняется в противофазе и светодиод MMC горит. Эта операция 
занимает несколько минут. 

5. Если операция прошивки завершается успешно, то светодиоды 
PWR, STOP, SF, FRCE и MCC горят постоянно. Если 
светодиоды мигают быстро, то произошла ошибка операции.  

6. Выключите и включите питание. ЦПУ проверит наличие файлов 
прошивки на MMC. Если файлы прошивки доступны, то 
светодиоды SF и FRCE начинают мигать. Выполните повторно 
действия, указанные в пункте 3.  

7. Если светодиоды SF и FRCE не мигают, значит операция 
прошивки выполнена.  

8. После завершения прошивки выполните сброс параметров 
ЦПУ к заводским уставкам (см. описание ниже). После этого 
ЦПУ готов к работе. 
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Перенос 
прошивки с MMC 
в ЦПУ 
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Сброс к заводским уставкам  
 

Описываемая ниже процедура выполняет полную очистку внутренней  
памяти RAM ЦПУ и сбрасывает параметры ЦПУ к заводским уставкам. 
Пожалуйста, обратите внимание, что IP адрес интерфейса  Ethernet 
PG/OP станет равным 0.0.0.0 и MPI адрес станет равным 2! 
"Заводской сброс" – сброс параметров ЦПУ к заводским уставкам 
можно выполнить также с помощью MMC-команды FACTORY_ RESET. 
Более подробная информация приведена в разделе "Командный 
файл MMC-Cmd". 
 
1. Переведите ЦПУ в режим STOP.  
2. Удерживайте функциональный переключатель в нижнем 
положении в течение 30 секунд. Вначале светодиод ST мигает 
несколько секунд, а затем начинает гореть постоянно. Изменение 
состояние светодиода повторяется несколько раз. Подсчитайте 
количество фаз с постоянным горением светодиода. 

3. После 6 фаз постоянного горения светодиода отпустите 
функциональный переключатель и вновь опустите его вниз в 
положение MRES на 1секунду.  

4. После завершения процедуры сброса светодиод RUN загорится на 
0.5 секунды. Если не удалось выполнить сброс к заводским 
уставкам по какой-либо причине, то процедуру сброса можно 
повторить. Сброс к заводским уставкам выполняется только после 
того, как было получено ровно  6 фаз постоянного горения 
светодиода ST. 

5. После этого выключите питание ЦПУ и включите снова. 
 
На рисунках показаны описанные выше процедуры: 

RUN
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MRES

PWR

RUN

STOP

SF

FRCE

MCC

30 Sec.

Tip

CPU in 
STOP

Request factory reset Start factory reset Factory reset
executed

1 3

PWR
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SF

FRCE

MCC

PWR

RUN
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FRCE

MCC

6x RUN
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MRES
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MRES
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2 4

PWR

RUN

STOP

SF

FRCE

MCC

PWR

RUN

STOP
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FRCE

MCC Power
OFF/ON

Error: Only
overall reset
executed

5

 
 

Внимание! 
После обновления прошивки всегда необходимо выполнять сброс к 
заводским уставкам. 

Описание 
процедуры 
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Расширение памяти с MCC 
 

Введение 

 

В ЦПУ фирмы VIPA возможно расширение рабочей памяти. Для этого 
используется MCC карта расширения. MCC – это специально 
подготовленная MMC (Multimedia Card). Для использования 
расширенной памяти требуется выполнить полный перезапуск после 
того, как MCC карта вставлена в MCC слот. Одновременно можно 
использовать только одну карту.  
На MCC карте находится файл memory.key. Этот файл нельзя 
изменить или удалить. Вы можете использовать MCC как "обычную" 
MMC для хранения проекта.  

 

Для расширения памяти вставьте карту MCC в слот MCC ЦПУ 
отметкой "MCC" и выполните полный перезапуск.  
 

CPU
Tip

3Sec.

Overall reset

MCC

memory is extended for the MCC memory
configuration (diagnostic entry 0xE400)

MMCRN

ST

MR

 
 

Если размер устанавливаемой памяти превышает максимально 
допустимый размер для ЦПУ, то будет использоваться максимально 
возможный размер памяти для данного ЦПУ.  
Вы можете увидеть текущий размер рабочей памяти на встроенном 
web-интерфейсе или, используя SIMATIC Manager, в окне Module 
Information - "Memory". 
 

Внимание! 
Пожалуйста, обратите внимание, что после расширения памяти, МСС 
должна находиться в слоте постоянно. Если извлечь МСС, то по 
истечении 72 часов ЦПУ перейдет в режим STOP. MCC нельзя 
заменить другой MCC, даже с тем же  размером памяти. 
 

ЦПУ генерирует сообщение с кодом 0xE400 после расширения 
памяти. Это сообщение можно найти в  диагностическом буфере ЦПУ. 
Если извлечь MCC, то ЦПУ генерирует сообщение с кодом 0xE401 и 
светодиод  SF загорается. Время, оставшееся до останова ЦПУ, 
отображается на Web-интерфейсе в качестве параметра MCC-Trial-
Time. По истечении 72 часов ЦПУ перейдет в режим STOP. 
Восстановление работоспособности ЦПУ возможно в случае полного 
перезапуска или возврата той же самой MCC.После возврата MCC, 
светодиод SF-LED погаснет и будет сгенерировано сообщение с 
кодом 0xE400. 
Для сброса конфигурации памяти ЦПУ необходимо выполнить полный 
перезапуск без MCC. 

 

Порядок 
действий 

 

Поведение 
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Расширенная know-how защита  
 

Кроме  "стандартной" Know-how защиты, ЦПУ фирмы VIPA на основе 
технологии SPEED7 обеспечивает "расширенную" know-how защиту, 
которая обеспечивает гарантированную защиту блоков от доступа к 
ним третьих лиц.  
 
При использовании стандартной защиты, предусмотренной фирмой 
Siemens, защищенные блоки переносятся на программатор, но  
содержимое блоков не показывается. Но существуют определенный 
набор действий, который снимают эту защиту. 
 
"Расширенная" know-how защита разработана фирмой VIPA и 
предусматривает сохранение защищенных блоков только в ЦПУ.  
При использовании "расширенной" защиты Вы переносите 
защищенные блоки в WLD-файл  с именем protect.wld. Вставив MMC и 
выполнив полный перезапуск, блоки в проекте protect.wld. будут 
сохранены в ЦПУ. 
Вы можете защитить OB, FB и FC. 
При выгрузке защищенных блоков на программатор, выгрузятся 
только заголовки блоков. Исходные коды останутся в ЦПУ и они 
защищены от доступа к ним третьих лиц. 
 

CPU
Tip

3Sec.

MMC

protect.wld

Blocks

wld file

PC OVERALL_RESET

protected Blocks
are located in the CPU

MMCRN

ST

MR

 

 
Создайте новый wld-файл в среде программирования выбрав 
подпункт меню File > Memory Card file > New и назовите его 
"protect.wld".  
Перенесите соответствующие блоки в файл, перетаскивая их с 
помощью мыши из проекта в окно проекта protect.wld. 
 

Введение 

Стандартная 
защита  

Расширенная 
защита  

Защита блоков с 
помощью 
protect.wld 
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Запишите файл protect.wld на MMC, затем вставьте MMC в ЦПУ и 
выполните полный перезапуск, выполняя действия, показанные на 
рисунке ниже: 
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Полный перезапуск сохраняет блоки в файле protect.wld в ЦПУ, 
защищая их от доступа к ним третьих лиц. 
 

Защищенные блоки переписываются новым файлом protect.wld. 
Используя программатор, любой человек может обращаться к 
защищенным блокам, но на программатор будут перенесены только 
заголовки блоков. Код защищенного блока остается в ЦПУ и его 
нельзя прочитать. 
 

Защищенные блоки в RAM ЦПУ можно заменить в любой момент 
блоком с тем же самым номером. Измененный блок остается в RAM 
до полного перезапуска. Защищенные блоки можно переписать 
навсегда, только если они удалены из файла protect.wld. 
Если перенести пустой файл protect.wld с MMC в контроллер, то будут 
удалены все защищенные блоки.  
  

Поскольку при чтении "защищенных" блоков нет доступа к коду блока, 
то этот факт удобно использовать для создания "оболочки блока " для 
конечного пользователя.  
Для этого создайте проект без защищенных блоков, предоставив 
возможность редактировать остальные блоки. 

Перенос  
protect.wld  в  
ЦПУ с полным 
перезапуском  

Проявление 
защиты  

Замена 
защищенных 
блоков  

Использование 
защищенных 
блоков 
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Командный файл MMC-Cmd 
 

Командный файл на  MMC будет загружен автоматически один раз 
после того, как MMC будет вставлена, при следующем включении 
питания при нахождении ЦПУ в режиме STOP. 
Командный файл - это текстовый файл, который содержит 
последовательные команды, сохраненные в виде файла 
vipa_cmd.mmc в корневой директории MMC. 
Файл начинается с CMD_START, затем следуют необходимые 
команды (без другого  текста) и заканчивается командой CMD_END. 
После последней команды CMD_END разрешены комментарии, т.к. 
этот текст игнорируется. Как только командный файл будет распознан 
и выполнен, каждое действие сохраняется в ММС в файле logfile.txt. 
Кроме того, каждая выполненная команда может быть найдена в 
диагностическом буфере.    
 

В приведенной ниже таблице описываются возможные команды. 
Пожалуйста, обратите внимание на последовательность команд, 
которые должны начинаться с CMD_START и заканчиваться 
CMD_END. 
 

Команда Описание Код диагностики 
CMD_START CMD_START размещается в первой строке  0xE801  
 Код диагностики, когда CMD_START отсутствует 0xE8FE 
WAIT1SECOND Приостановить выполнение на 1секунду 0xE803 
WEBPAGE Текущая web-страница CPU сохраняется на MMC в 

файле "webpage.htm" 
0xE804 

LOAD_PROJECT Функция "Полный перезапуск и перезагрузиться с 
MMC" выполняется. Если после команды указан 
Wld файл, то он загружается, иначе загружается 
файл "s7prog.wld"  

0xE805 

SAVE_PROJECT Последний проект (блоки и аппаратная 
конфигурация) сохраняется в файл "s7prog.wld" на 
MMC. Если файл уже существует, то он 
переименовывается в "s7prog.old" 

0xE806 

FACTORY_RESET Выполнение "Заводской сброс " – возврат заводских 
уставок 

0xE807 

DIAGBUF Текущий диагностический буфер ЦПУ сохраняется в 
файл "diagbuff.txt" на MMC 

0xE80B 

SET_NETWORK Присваиваются IP параметр Ethernet PG/OP канала. 
При присваивании IP параметров необходимо 
соблюдать следующий порядок: IP адрес, маска 
подсети, шлюз. Параметры должны быть указаны в 
формате xxx.xxx.xxx.xxx  и разделены запятой. 
Введите просто IP адрес,  если шлюз не 
используется. 

0xE80E 

CMD_END CMD_END размещается в последней строке 0xE802 
 

Введение 

Команды 
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Структура команд приведена ниже. Соответствующий код диагностики 
приведен в скобках. 
 
 
 

CMD_START Отмечает начало последовательности команд (0xE801) 
LOAD_PROJECT proj.wld Выполнить полный перезапуск и загрузить "proj.wld" 

(0xE805) 
WAIT1SECOND Приостановить выполнение на 1секунду (0xE803) 
WEBPAGE Сохранить web-страницу в "webpage.htm" (0xE804) 
DIAGBUF Сохранить диагностический буфер ЦПУ в "diagbuff.txt" 

(0xE80B) 
CMD_END Отмечает конец последовательности команд (0xE802) 
... arbitrary  text ... Текст после CMD_END не обрабатывается  

 
 
 
 

CMD_START Отмечает начало последовательности команд (0xE801) 
LOAD_PROJECT proj2.wld Выполнить полный перезапуск и загрузить "proj2.wld" 

(0xE805) 
WAIT1SECOND Приостановить выполнение на 1секунду (0xE803) 
WAIT1SECOND Приостановить выполнение на 1секунду (0xE803) 
SET_NETWORK 172.16.129.210,255.255.224.0,172.16.129.210 IP параметры  

(0xE80E) 
WAIT1SECOND Приостановить выполнение на 1секунду (0xE803) 
WAIT1SECOND Приостановить выполнение на 1секунду (0xE803) 
WEBPAGE Сохранить web-страницу  в "webpage.htm" (0xE804) 
DIAGBUF Сохранить диагностический буфер ЦПУ в "diagbuff.txt" 

(0xE80B) 
CMD_END Отмечает конец последовательности команд (0xE802) 
... arbitrary  text ... Текст после CMD_END не обрабатывается 

 
 

Внимание! 
IP адрес, маска подсети и шлюз должны быть получены у системного 
администратора.  
Введите просто IP адрес,  если шлюз не используется. 
 

Примеры 

Пример 1 

Example 2 
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Специфические  диагностические данные ЦПУ фирмы VIPA 
 

Вы можете прочитать содержание диагностического буфера ЦПУ, 
используя SIMATIC Manager фирмы Siemens. В дополнении к 
стандартным сообщениям в диагностическом буфере, ЦПУ фирмы 
VIPA поддерживает дополнительно определенные события в форме 
идентификатора события (Еvent-ID). 
Текущее содержание диагностического буфера сохраняется на MMC 
по команде DIAGBUF. Для получения более подробной информации 
обратитесь к руководству "Командный файл MMC-Cmd". 
 

Внимание! 
Вся информация, отображаемая в окне «Module information», 
поддерживается ЦПУ фирмы VIPA. Для получения более подробной 
информации обратитесь к он-лайн руководству в SIMATIC manager. 
 

Для просмотра диагностических сообщений необходимо выбрать 
подпункт меню PLC > Module Information в SIMATIC Manager. В 
закладке "Diagnostic Buffer" расположено диагностическое окно, 
указанное ниже на рисунке: 
 

 
 
Диагностика не зависит от режима ЦПУ. ЦПУ может хранить до 100 
диагностических сообщений. 
Приведенная ниже таблица содержит дополнительно определенные 
события. 

События в 
диагностическом 
буфере 

     

Просмотр 
диагностических 
сообщений 
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Event-ID Описания  
0xE003 Ошибка доступа к устройствам ввода/вывода  

Zinfo1: адрес ввода/вывода 
Zinfo2: номер слота 

0xE004 Многократное задание адреса ввода/вывода в конфигурации оборудования  
Zinfo1: адрес ввода/вывода 
Zinfo2: номер слота 

0xE005 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки  
0xE006 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки  
0xE007 Сконфигурированный байт ввода/вывода выходит за пределы области 

входов/выходов 
0xE008 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки  
0xE009 Ошибка обращения к задней шине 
0xE010 Обнаружены модули на задней шине, не описанные в конфигурации 

Zinfo2: номер слота  
Zinfo3: тип ID 

0xE011 На slave ЦПУ сконфигурировано master-устройство или ошибка конфигурации 
slave -устройства  

0xE012 Ошибка параметрирования 
0xE013 Ошибка обращения к регистру сдвига стандартной шины дискретного модуля  
0xE014 Ошибка Check_Sys 
0xE015 Ошибка обращения к master-устройству 

Zinfo2: адрес слота master-устройства (32=ошибка обращения к страничному 
кадру) 

0xE016 Превышен максимальный размер блока данных при передаче master-
устройством  
Zinfo1: адрес ввода/вывода  
Zinfo2: номер слота 

0xE017 Ошибка обращения к встроенному slave-устройству 
0xE018 Ошибка в карте памяти размещения устройств ввода/вывода в master-

устройстве  
0xE019 Ошибка распознавания стандартной задней шины  
0xE01A Ошибка определения режима работы (8/9 бит) 
0xE01B Ошибка – превышено количество установленных модулей  
0xE030 Ошибка стандартной шины  

  
0xE0B0 SPEED7 не остановлен (возможно не определено значение BCD в таймере) 
0xE0C0 Недостаточно места в рабочей памяти для сохранения исполняемых блоков 

(превышен размер блоков) 
0xE0CC Ошибка связи MPI / Serial 
0xE0CD Ошибка управления заданиями на DPV1  
0xE0CE Ошибка. Тайм-аут при передаче диагностической информации от i-slave 

устройства 
продолжение... 

Перечень 
Event-IDs 
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... продолжение 

Event-ID Описание 
0xE100 Ошибка обращения к MMC 
0xE101 Ошибка файловой системы MMC 
0xE102 Ошибка FAT MMC  
0xE104 Ошибка записи в MMC 
0xE200 Запись в MMC закончена (Копирование Ram ->Rom) 
0xE210 Чтение из MMC закончено (перечитать данные после полного перезапуск) 
0xE21F Ошибка чтения из MMC: считывания данных (после полного перезапуска), 

ошибка чтения, нет свободной памяти  
  

0xE400 Карта расширения памяти MCC вставлена 
0xE401 Карта расширения памяти MCC изъята 

  
0xE801 MMC-Cmd: CMD_START воспринята и выполнена успешно 
0xE802 MMC-Cmd: CMD_END воспринята и выполнена успешно 
0xE803 MMC-Cmd: WAIT1SECOND воспринята и выполнена успешно 
0xE804 MMC-Cmd: WEBPAGE воспринята и выполнена успешно 
0xE805 MMC-Cmd: LOAD_PROJECT воспринята и выполнена успешно 
0xE806 MMC-Cmd: SAVE_ PROJECT воспринята и выполнена успешно 
0xE807 MMC-Cmd: FACTORY_RESET воспринята и выполнена успешно 
0xE80B MMC-Cmd: DIAGBUF воспринята и выполнена успешно 
0xE80E MMC-Cmd: SET_NETWORK воспринята и выполнена успешно 
0xE8FB MMC-Cmd:Ошибка инициализация Ethernet PG/OP канала по команде 

 SET_NETWORK 
0xE8FC MMC-Cmd: Ошибка: Не достаточно IP-параметров в команде SET_NETWORK. 
0xE8FE MMC-Cmd: Ошибка:  CMD_START не найдена  
0xE8FF MMC-Cmd: Ошибка при чтении CMD файла (ошибка MMC) 

  
0xE901 Ошибка контрольной суммы 

  
0xEA00 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки! 
0xEA01 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки! 
0xEA02 SBUS: Внутренняя ошибка (не опознан подключенный внутренний субмодуль) 

Zinfo1: номер внутреннего слота 
0xEA04 Ошибка доступа к устройствам ввода/вывода  

Zinfo1: адрес ввода/вывода 
Zinfo2: номер слота  
Zinfo3: Размер данных  

0xEA05 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки! 
0xEA07 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки! 
0xEA08 SBUS: Заданный размер входных данных не соответствует размеру входных 

данных установленных модулей 
Zinfo1: Заданный размер входных данных  
Zinfo2: Номер слота  
Zinfo3: Размер входных данных установленных модулей  

продолжение... 
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... продолжение 

Event-ID Описание 
0xEA10 SBUS: Адрес входа выходит за область входов  

Zinfo1: адрес ввода/вывода 
Zinfo2: Номер слота 
Zinfo3: Размер данных 

0xEA11 SBUS: Адрес выхода выходит за область выходов  
Zinfo1: адрес ввода/вывода 
Zinfo2: Номер слота 
Zinfo3: Размер данных 

0xEA12 SBUS: Ошибка записи набора данных  
Zinfo1: Номер слота  
Zinfo2: Номер набора данных  
Zinfo3: Длина набора данных  

0xEA14 SBUS: Многократное задание адреса I/O в конфигурации оборудования  
Zinfo1: адрес ввода/вывода 
Zinfo2: номер слота 
Zinfo3: Размер данных  

0xEA15 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки! 
0xEA18 SBUS: Ошибка в карте памяти размещения устройств ввода/вывода в master-

устройстве  
Zinfo2: Номер слота master-устройства 

0xEA19 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки! 
0xEA20 Ошибка - RS485 интерфейс не назначен Profibus DP master-устройству, но 

Profibus DP master-устройство сконфигурировано  
0xEA21 Ошибка при проектировании интерфейса X2/X3 RS485: 

Profibus DP master сконфигурирован, но отсутствует  
Zinfo2: Интерфейс x 

0xEA22 Ошибка интерфейса X2 RS485 - значение вне диапазона 
Zinfo: Сконфигурированное значение X2 

0xEA23 Ошибка интерфейса X3 RS485 - значение вне диапазона 
Zinfo: Сконфигурированное значение X3 

0xEA24 Ошибка при проектировании интерфейса X2/X3 RS485: 
Интерфейс/протокол отсутствует, но используются установки по умолчанию 
Zinfo2: Сконфигурированное значение X2 
Zinfo2: Сконфигурированное значение X3 

  
0xEA30 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки! 
0xEA40 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки! 
0xEA41 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки! 

  
0xEA98 Превышен тайм-аут при перезагрузке SBUS модуля (Сервер)  
0xEA99 Ошибка чтения файла через SBUS 

  
0xEE00 Внутренняя ошибка. Пожалуйста, обратитесь в службу поддержки! 
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Использование диагностических функций  
 
Для диагностических целей и отображения значения переменных Вы 
можете использовать диагностические функции, предусмотренные в 
SIMATIC Manager. 
Значение переменных и результат логической операции (RLO) можно 
увидеть, если вызывается тестовая функция с помощью меню Debug 
> Monitor. 
Вы можете изменять и/или проверять значения переменных, вызвав 
диалоговое окно из пункта меню PLC > Monitor/Modify Variables. 
 

Применение этой  функции  отображает значение переменных и RLO 
различных операндов во время выполнения программы.   
После активации этой функции Вы имеете возможность внести 
изменения в ход выполнения программы (изменить значения 
переменных, установить точки останова и т.д.). 
 

Внимание! 
При использовании функции “Monitor” (наблюдение) ПЛК должен 
находиться в режиме RUN! 
 

Фрагменты кода могут не выполняться вследствие инструкций 
перехода в блоках обработки событий от таймера или прерываний. В 
этом случае ЦПУ не выполняет сбор данных и вместо текущих данных 
передает в программатор значения, равные нулю, для следующих 
параметров: 
 

• результат логической операции (RLO) 

• Бит состояния / Содержимое аккумулятора 1 

• Содержимое аккумулятора 2 

• Байт флагов 

• Адресные регистры. Их содержимое отображается в виде "?". 
 
 
Эта функция отображает значение операнда  (входы, выходы, флаги, 
слова данных, счетчики или таймеры) в конце цикла выполнения 
программы   
Эта информация считывается из образа процесса. Во время 
"processing check" или в режиме STOP значения считываются 
непосредственно с входов периферийных устройств. Иначе всегда 
отображаются значения операндов из образа процесса. 
 

Введение 

Debug > Monitor 

    

PLC > 
Monitor/Modify 
Variables 
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Управление выходами 
Управляя выходами, можно проверить правильность подключения и 
правильность операций с выходными переменными.   
Вы можете установить любое желаемое значение выходной 
переменной в любое значение из программы или без нее. Образ  
входов не изменяется, в то время как образ выходов изменяется. 
 
Управление переменными  
Вы можете изменять переменные следующих типов: 
I, Q, M, T, C и DB. 
Значение образа процесса можно изменять независимо от режима 
ЦПУ.    
Когда ЦПУ находится в режиме RUN, программа выполняется с 
измененными переменными. При дальнейшем выполнении программы  
переменные могут быть изменены программой без уведомления. 
Изменение значений переменных выполняется асинхронно по 
отношению к выполнению программы. 
 
 

 


